




FLUX started with a passion for digital creation and 
making intuitive and affordable tools for makers and 
designers. Since its inception, FLUX has been working on 
developing quality built tools for creative people like you. 
Now, there are tens of thousands of FLUX users in over 75 
countries worldwide.
We’re here to proudly present the FLUX beamo, the 
culmination of our experience in laser technology. To help 
you make the most of your creativity with beamo, we 
spent every effort on editing this book. With this book, 
you’ll learn the basics of laser cutters, the features of 
various materials, how to keep the machine at its best 
status, and numerous design inspirations.
In pursuit of the goal we’ve had since day one, we work 
closely with our users, so please don’t hesitate to contact 
us; we look forward to your feedback. You can always 
reach us at support@flux3dp.com.
Finally, thanks for your support in joining our mission, we 
will continue to innovate for this incredibly exciting time. 
We sincerely hope you enjoy using this machine.

Cheers,

FLUX Team

WELCOME TO THE FLUX COMMUNITY!



Warning: 

You must read and observe the following instructions carefully before using the 
product for the first time. Non-observance of individually listed points in the 
instructions manual can cause personal injury and/or property damage!

All rights reserved. No part of this Manual may be edited or otherwise modified 
in any form without the prior written consent of FLUX Inc.

The rights for reproduction in any form or by any means, electronic, 
mechanical, or photocopying, are reserved. FLUX Inc. reserves the right to 
change the specifications of the hardware and software described in these user 
manuals at any time and without prior notice.

Please keep this user manual for future reference, and make sure you have the 
latest version of the beamo user manual.

The latest version of the user manual can be found at: 
https://support.flux3dp.com/hc/en-us/categories/5110933719951

USING THIS 
USER MANUAL

This icon represents a notice for the user. Please pay 
particular attention to the possible dangers.



FLUX beamo is a 30W CO2 laser cutter and engraver. Whether you’re a first-time 
user or a more advanced professional, beamo’s straightforward, intuitive ecosystem 
makes it easy and hassle-free to go from design to product. beamo can engrave 
and cut through various materials and customize a dynamic range of products in 
any unique shape or style. Ultra-fine laser engraves at an exceptional depth with a 
clear resolution of 1000 DPI fitting for any craft or small business project.

FLUX beamo comes fully equipped with Wi-Fi connectivity for a seamless workflow. 
Monitor work status, transfer files, or update settings plus, preview your design and 
drag and drop it to the exact position you want, or use auto alignment to get that 
perfect center configuration. The built-in camera makes it easy to engrave, cut, and 
even flip and cut again without worrying about problematic placements. Just scan 
the bed, drag your design and start your cut or engraving.

Designers can benefit from Beam Studio’s seamless integration of Adobe Illustrator 
or import designs from AutoCAD, Inkscape, CorelDraw, and even Microsoft Word. 
Upload your high-quality designs in JPG, PNG, SVG, or DXF. Once you’re ready to 
engrave or cut, enjoy preset parameters for power and speed based on your choice 
of materials.

Safety is a paramount at FLUX. FLUX beamo is designed for safety and is fully 
enclosed, it will automatically pause when the lid is opened during a task. 

At FLUX, we believe in making high-quality, high-performance laser technology 
accessible to everyone. Our laser engravers are backed by a standard of excellence 
in both functionality and usability, empowering you to create more of what you 
love with confidence and ease.

FLUX Inc.
1F., No. 79-3, Ln. 209, Sec. 2, Xinnong St., 

Yangmei Dist., Taoyuan City 326015, Taiwan

Manufacturer

beamo
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Labels

The beamo has 7 labels in total.
Warning labels describe potential risks. 
Please familiarize yourself with all safety 
guidelines before use.
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Labels

CH 1-1

1. Product label

2. Warning labels

On the bottom right corner of the rear of the machine

On the right side of the first reflective 
mirror outlet (circle outlet)

Power button
On the rear of 
the machine

On the rear of the machine

On the door cover

Below the screen
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Safety
Regulations

Please read the following safety precau-
tions carefully before starting to operate 
the beamo. beamo generates high power 
laser, improper operation may result in fire, 
visual impairment, skin burns, or inhalation 
of toxic substances, and other hazards to 
personal and property safety.
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Safety Regulations

CH 1-2

Do not leave beamo unattended. Press the pause button if you need to leave.

Do not stare at the laser flashes con-
stantly. 

Please confirm that the engraving material 
will not be dangerous when burned at 
high temperature. 

Always have a functioning fire 
extinguisher in the working 
environment.

Do not disassemble the beamo without 
the authorization of FLUX.

Any usage or safety concerns are welcome to be confirmed with FLUX.

support@flux3dp.com / (+886) 2651-3171
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Operators

˙Confirm that the person who intends to operate the machine has
read the safety precautions carefully and followed the instructions 
in the manual.

˙The repair or modification process can only be done by the 
authorized technician of FLUX. Repair by the user is not intended.

˙Do not modify the machine without official authorization.
˙Do not let minors operate alone.
˙Do not disassemble the electrical cabinet to avoid the risk of 
   electric shock.

Working Environment

˙Place the machine on a stable surface to prevent it from falling
over, do not overhang or tilt the machine.

˙Place the machine in a well-ventilated indoor space with windows. 
   Do not place the machine outdoors, in the basement, under a
   metal roof, direct sunlight or in other confined spaces.
˙Connect the vent hose of the machine to the outdoor.
˙In case of rain or extreme weather, please stop using the machine

and put the vent hose inside.Do not place the machine in a humid, 
splashing rain or direct sunlight space.

˙Ensure that the machine is stored at a temperature between
5°C - 40°C and a humidity between 10% - 75%. Keep the machine 
working environment from 5°C - 25°C (if the power is below 40%, 
the room temperature is relaxed to 5°C - 30°C).
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˙Do not place liquid, flammable, or explosive objects near the
   machine.
˙Do not let children play and frolic in the area where the machine 
    is placed.

Safety Regulations

CH 1-2

˙Regularly clean the debris under the honeycomb table of the 
machine.

˙If flame is generated on the engraving material during laser work,
please turn off the power immediately and unplug the power 
cord at the back of the machine, then use a wet towel to 
extinguish the fire. Please pay attention to the possibility of 
irreversible damage caused by water in the machine.

˙If the flame is relatively large, please use a fire extinguisher.
Please note that the dry powder or foam in the fire extinguisher 
may cause irreversible damage to the machine.

˙If the flame is uncontrollable, please call the fire department for
assistance immediately.

Fire Risk

˙Do not use the material that is not suitable for lasers to be placed 
into the machine from the “Material Tips - Hazardous Materials 
(p.119)” for more information.

˙Do not stack materials in the machine, such as trying to cut
multiple boards at once.

˙Do not allow the machine to operate unattended.
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Do not allow the wires and plugs to be damaged, close to the 
heating apparatus, or forced to bend, twist, pull, and carry heavy 
objects.

˙Ensure that the operation power of ordered model is under 110V 
or 220V.

˙Ensure that the 3rd hole of the socket is grounded. If the 
grounded is not confirmed, it may cause static interference and 
affect the performance and even increase the risk of electric 
shock.

˙If you find the power cord is damaged, please stop using the 
machine immediately.

˙Always turn off the power and disconnect the plug when clean
ing and maintenance.

Power and Wires

Door Safety Interlock

˙When the cover is opened, the safety interlock will suspend the
operation of the machine and stop the output of laser.

˙Even if the machine is designed with the safety interlock, do
not put your hands, eyes, or other parts of your body near the 
operating area of the laser to avoid danger.

Do not try to modify, defeat or disassemble safety interlocks.
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Additional Operation Notes

˙Suggest two or more people to move the machine simultaneously
to avoid injury.

˙Suggest wearing gloves while cleaning to avoid being scratched
by honeycomb table or material.

˙In case of burns, please continue to flush cold water and consult a
doctor, do not use medicine by yourself.

˙When opening the cover, please make sure to wear a mask and
laser safety glasses with the protection level of OD5 (energy 
penetration rate 10-5).

˙There are no noise hazard concerns as the beamo's working level is
below 70 dB.

˙Do not constantly stare at the firelight during laser operation.
˙Do not impact or vibrate the machine. It may cause the optical

path to shift or damage the laser tube.
˙Do not place any living beings in the machine. It is strictly 
   prohibited.

Safety Regulations

CH 1-2

˙Connect the vent hose to the outside or to an air purifier to ensure 
that the exhaust does not affect neighbors or public spaces.

˙If you find strong odor or heavy smoke, please stop using
themachine. Make sure the vent hose is properly connected and 
the ventilation system is working properly before usage.

Ventilation
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To assess the potential hazards of laser systems, they are divided into eight 
safety classes: 1, 1C, 1M, 2, 2M, 3R, 3B, and 4. FLUX beamo is a Class 1 Laser 
Product. A class 1 laser product is a device the safest of all classes and complies 
with laser safety standards from the International Electrotechnical Commission 
(IEC). These regulations ensure that lasers identified with a “Class 1 laser 
product” are safe. This is guaranteed by its enclosed protective housing and its 
safety devices.

FLUX beamo works with a laser source that emits intense and invisible laser 
light. If the door cover is opened during the task, the interlock ensures the laser 
stops. Safety interlock switches on the front panel turn off the laser immediately 
if they are opened. Do not place magnets near the front panel or doors as they 
can interfere with the switches. Do not try to defeat the switches.

The accessible laser light is hazardous to the eye and the skin if the protective 
housing or interlock is defeated, modified or removed. Without protective 
devices, this direct light or diffused reflected light is dangerous to both persons 
and objects!
Do not modify or disassemble your beamo. Attempting to modify or service the 
unit may result in hazardous laser light exposure. All service must be performed 
only by factory-authorized technicians or only be modified with official 
authorization.

Laser Safety

Work Position of Operator

Operator
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Safety Regulations

CH 1-2

The latest version of the declaration of conformity can be downloaded from: 
https://flux3dp.com/declaration/

EU Declaration of Conformity

17
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Product 
Specifications

This manual is applicable to beamo.
Software version: 1.7.X.
Firmware version: 3.5.X.
The illustrations are mainly for Mac. 
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Product Specifications

CH 1-3
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Laser 
Engraving 
Principle

The principle of laser engraving is to focus a 
high-power laser beam on the surface of the 
engraving material, and the material will be 
instantly heated or vaporized after absorbing 
the high energy of the laser, thus creating an 
indentation or even a cut in the working path 
of the laser beam.
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Reflective Mirror

First Reflective Mirror

Third Reflective Mirror

Second Reflective Mirror
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Laser Tube

Focus Lens

Laser Engraving Principle

CH 1-4
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Reflective Mirror

Laser Principal

There are three reflective mirrors inside the machine, the 
first mirror is fixed while the second and third mirrors can 
be driven by the motor to pan around in order to direct 
the laser beam to any position on the working table. The 
second mirror will move forward and backward, which is 
to control the position of the Y-axis, while the third mirror 
moves left and right to control the X-axis.

First Reflective Mirror

Second Reflective Mirror

Third Reflective Mirror

Optical Path
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Laser Tube

Focus Lens

The beamo is equipped with a 30W CO2 laser, where the 
CO2 gas is sealed inside a glass tube and when the voltage 
is applied to both ends of the laser tube, the gas is excited 
producing an invisible laser with a wavelength of 10.6 μm. 
When the light is emitted from the end of the laser tube, 
it is a parallel beam of about 5 mm in diameter. Due to 
the small divergence, the parallel beam can be transmitted 
inside the machine with little energy loss.

After the third reflection, the laser beam will be directed 
to the surface of the engraving material. To achieve higher 
energy density, a glass focus lens inside the laser head will 
focus the parallel beam of about 5mm diameter to about 
0.2mm diameter. If the laser beam is properly focused on the 
surface of the material, the energy is sufficient to instantly 
burn through non-metallic materials such as wood, acrylic, 
or metal materials after anodizing, or stainless steel after 
specific spray processing.

Exploded view 
of laser head

Laser Engraving Principle

CH 1-4
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Unboxing

The beamo weighs 22 kilograms. It is 
recommended to have two people lift 
it cooperatively to avoid injury.
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Remove the four corners of the cushioning material and take out 
the machine from the carton to place it on a stable surface. Please 
preserve the original carton and cushioning material for future 
usage.

03

Opening the box, it contains the machine (including the vent hose), 
and the accessory box (including the manual).01

The accessory box contains 1｜Torx screwdriver, 2｜2.5mm hexagonal 
wrench, 3｜Double head wrench, 4｜Lubricating oil, 5｜Funnel, 
 6｜Ethernet cable, 7｜Double-sided tape, 8｜Clamp, 9｜Power cord, 10
｜Wi-Fi dongle, 11｜Engraving sample, 12｜Wood piece.

02

Unboxing

CH 2-1

1 2 3 4 5

6 7 8

9 10
12

11
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1

2

3

04 Machine front：
1 ｜ Nozzle fastening ring、2 ｜ Focus probe、3 ｜ Honeycomb table
4 ｜ Power button、5 ｜ Touch panel、6 ｜ Acrylic door cover
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Machine front：
1 ｜ Nozzle fastening ring、2 ｜ Focus probe、3 ｜ Honeycomb table
4 ｜ Power button、5 ｜ Touch panel、6 ｜ Acrylic door cover

4

5

6 05

21 3 4

Machine back：
1 ｜ USB port

2 ｜ Ethernet port

3 ｜ Power port

4 ｜ Ventilation fan

Unboxing

CH 2-1
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Assembly and 
Start-up

Please read the safety regulations 
carefully before starting the operation.
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01
02

03

04

Install the power cord and vent hose at the back of the machine to turn on the 
power and start usage.

Insert both ends of the power cord into the rear side of the machine and 
into the outlet.

Insert the clamp from the smaller end of the vent hose and put the 
larger end of the vent hose on the back side of the machine, then use 
the double head wrench provided in the accessory box to adjust the 
tightness of the clamp until the vent hose is not easily loosened.

Press the power button to turn on the machine, the first time it takes 
about two minutes to turn on.

Before engraving, you need to change the language and 
network in the machine as well as download the software 
and set up the network in the computer in order to match 
the computer and the machine.

Assembly and Start-up

CH 2-2

First unboxing, please follow the machine test guide to select interface 
language, to read FIRE HAZARD carefully (as shown in the next page), 
to do the Startup Test, and to set the internet connection. Please refer to
【Connection Settings】( p.52 ) for other connection methods. Make sure 
the device connected to the machine and the machine itself are using the 
same local area network.

Make sure to install the vent hose properly. Exhaust hose missing or not 
installed properly will increase the risk of fumes and dust inhalation.
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CH 2-3

Machine 
Interface

This chapter will introduce the machine 
interface and the seven key functions.
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Machine Interface

CH 2-3

A

B

DC

FE

G
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A：Status Bar

B：START

C：MAINTAIN

E：NETWORK

D：APP

F：MACHINE

G：HELP CENTER

Machine status checking

Work file manager

Mechanism switch, usage during 
maintenance, repair, and troubleshooting

Matching mobile devices and machines

Network status checking, network setting

Machine name search, language and 
hardware related settings

Help Center access
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A：Status Bar
Machine status checking

The status bar shows the connection status of the machine, whether it is connected 
to Beam Air or not as well as the temperature, water flow and door opening/closing 
status when the work is in progress. Most of the time, clicking on the status bar will 
return to the home page, during carving will reorganize the page.

Status Bar

In Progress

Door cover 
opened

Wireless 
network

Door cover 
closed

Ethernet 
network

Out of 
Progress

Icons

Beam AirTemperature

Door cover

Water pump

Network 
connection

BABeam Air
Temperature /   

Machine Interface

CH 2-3
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There are two ways to transfer the working tasks, either by Beam Studio software or 
by USB flash drive, both of which can be used to find and use the files from "START" 
after transfer.

1. Tasks sent to the machine from Beam Studio : “Built-in Memory” > “Recent” > 
specific tasks.
The machine can record up to 15 tasks sent by the software Beam Studio, and 
recent-01.fc will be the latest task sent.

2.  Files read from USB flash drives : USB flash drives > specific tasks.
There is no limit to the number of files that can be viewed on a USB flash drive.

B：START
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Work file manager

When you click a Work/File, the actual position of the image in the working area, 
the estimated working time, and the real-time power and speed setting multiplier 
will be displayed on the screen.

The starting point can be set manually before work, and the power rate and speed 
rate can be set instantly during work.

Manual start point setting: The start point is the zero position (0,0), click         > 
Move the laser head to the appropriate position through the control panel > OK.

Machine Interface

CH 2-3
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Mechanical switch for maintenance, 
repair, and troubleshooting

Maintenance and repair 
will enter the MAINTAIN 
page, mainly for hardware 
switch and signal display, it 
is highly recommended to 
read the subsequent main-
tenance chapter or through 
the customer service guide 
before operation.

C：MAINTAIN
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D：APP
Matching mobile devices 

and machines

After downloading the 
mobile version of Beam 
Go and connecting your 
mobile device to the same 
wireless network, click on 
the APP and scan the QR 
code to pair your mobile 
device with your machine.

* Beam Go is the mobile 
version of the Beam 
Studio software for 
mobile devices.

Machine Interface

CH 2-3
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Network status checking, 
network settings

Network IP address can be confirmed and 
whether the Wi-Fi dongle or the  Ethernet 
cable is normal (the MAC address has a 
value when normal).

Advanced Settings : You can set the 
Static IP manually for the machine, which 
requires filling in the IP address, subnet 
mask and router.

Start Remote Assistance : Guided by 
customer service.

Note: When using a wireless (Wi-Fi) or wired network (except for Direct connec-
tion), the machine can automatically obtain an IP address through DHCP (for general 
users) or be manually set to a Static IP.

E：NETWORK
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F：MACHINE

“Hardware Settings”, “Reset Laser Usage”, and “Reset to Factory” 
all require customer service guidance before operation to avoid 
consumer disputes caused by machine damage.

If you have any questions, please click "HELP CENTER", scan the QR code, and find 
possible solutions from the Help Center of FLUX official website.

Machine name search, language, and 
hardware related settings

Machine Interface

CH 2-3



48

Firmware upgrade takes a few minutes, do not 
turn off the machine during the process.

Once the connection password is set, it is required to enter the connection password 
in the software when connecting to the machine for the first time, and it can be 
modified and cancelled.

Clicking "Update to the latest Firmware" will update the firmware to the latest beta 
version. In addition to updating the firmware using the machine, you can also update 
the machine's firmware through the software interface. See【Software Operation】  
"Menu" - "Machines" (p.91). Or update the machine's firmware through the USB flash 
drive. (storage size <= 64GB, with format as FAT32; rename the firmware file down-
loaded from the website as autoupdate.fxfw. Restart the machine after plugging the 
USB flash drive into a USB port in the back of the machine.）

Machine name search, language, and 
hardware related settings
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G：HELP CENTER
Help Center access

If you have any questions, please click "HELP CENTER", scan the QR code, and find 
possible solutions from the Help Center of FLUX official website.

Machine Interface

CH 2-3
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Software 
Installation
and Activation

Download the latest Beam Studio 
version from the official FLUX website.



51

Software Installation and Activation

CH 2-4

Please go to the official FLUX website > “Supports” > "Downloads" and select the 
Beam Studio version from the drop-down list according to your operating system.

In case of  unable to open because it is from an unidentified 
developer, please open “System Preferences” > “Security & 
Privacy” > click on the lock to modify > “Open Anyway”.

For macOS :

Confirm the mac version to 
download the corresponding file. 
Some features are not available 
on older Mac versions. For system 
version information:  > “About 
This Mac” > Version.
Once you have finished down-
loading, click on the file in the 
Downloads section, use the 
cursor to drag the icon into the 
folder, and click on Beam Studio 
in the application.

For Windows :

Download the corresponding files 
according to your computer's op-
erating system bit: X86 for 32-bit 
and X64 for 64-bit. 
After downloading, please run 
Beam + Studio + Installer (.exe) 
and Beam Studio is ready to use. 
Beam Studio can be opened 
on the desktop or in C:\Users\
User\AppData\Local\Programs\
beam-studio\Beam Studio.

【Troubleshooting】 Unable to Open Software Properly ( p.213 )

v1.8.3 - macOS 10.13+
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Connection 
Settings

This chapter explains the various 
connection installation methods, once the 
connection is completed, the machine can 
be operated from the computer.
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1 Wi-Fi 
a. Install the Wi-Fi dongle：

Remove the Wi-Fi dongle from the accessory box and install the dongle antenna 
at 90 degrees to any USB socket on the back of the machine for signal reception.

b. To set up the network of the machine [must use the same Wi-Fi (2.4GHz) as 
     your computer network]:

“NETWORK” > “Connect to Wi-Fi” > Select the Wi-Fi you want to use > Enter the 
Wi-Fi password and press “Confirm” > “NETWORK” > Confirm the “Wireless IP” of 
the machine.

c. Set the software interface display language :
Use the drop-down list to select the language, and then click “Next”.

There are three types of connection between computer and machine, namely Wi-Fi, 
wired network, and direct connection (direct connection has different setting steps 
depending on the operating system).

Connection Settings 

CH 2-5
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d. Membership Login :
Login to the membership, you can access more functions added to the software 
from time to time in the future. 

e. Select the connection method：
Select “Wi-Fi”.

f. Enter the IP address of the machine to complete the setting：
Check the “Wireless IP” address of the machine from the panel. Enter the wireless 
IP address of the machine into the computer to complete the setting.

2 Wired Network
a. Install the Ethernet cable :

Install both ends of the Ethernet cable in the network slot on the back of the 
machine and slot on the router. The machine will automatically connect to the 
network in about 10 seconds after the installation is completed.

d. Membership Login :
Login to the membership, you can access more functions added to the software 
from time to time in the future.

b. Confirm the machine network :
Confirm the value of Wired Network “MAC Address” of the machine in “NETWORK” 
page.

e. Select the connection method :
Select “Wired Network”.

c. Set the software interface display language :
Use the drop-down list to select the language, and then click “Next”.

f. Enter the IP address of the machine to complete the setting :
Check the "Wired IP" address of the machine from the panel. Enter the wired IP 
address of the machine into the computer to complete the setting.
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3 Direct Connection

a. Install the Ethernet cable :
Install both ends of the Ethernet cable in the network slot on the back of the 
machine and in the computer network slot.

b. Confirm the machine network :
Confirm the value of Wired Network “MAC Address” of the machine in “NETWORK” 
page.

Apart from connecting through a router (Wi-Fi / LAN), you can also connect directly 
to your computer via an Ethernet cable.

1. Windows : The method is applicable to Windows 10 system.

c. Enable Internet connection sharing :
“Settings” > “Network & Internet” > “Change adapter options” >

Connection Settings 

CH 2-5
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Right-click on the network you are using (Wi-Fi or Ethernet) > “Properties” > 
“Sharing” > Select “Allow other network users to connect through this computer's 
Internet connection” and “Allow other network users to control or disable the 
shared Internet connection” >
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After confirmation, the word “Shared” will be displayed under that network.
In the “Network Connections” window, the user will see more than two networks. 
There is also one “Unidentified network”, which is the network to which the machine 
is connected.

e. Membership Login :
Login to the membership, you can access more functions added to the software 
from time to time in the future. 

f. Select the connection method :
Select “Direct Connection”.

g. Enter the IP address of the machine to complete the setting :
Confirm the “Wired IP” address of the machine from the panel. Enter the wired 
IP address of the machine into the computer to complete the setting. It usually 
starts with 192.168.(If it starts with 169.254, it means the computer may be set up 
incorrectly or the network cable).

Connection Settings 

CH 2-5

Realtek PCle GbE Family Contro...
Unidentified Network

d. Set the software interface display language :
Use the drop-down list to select the language, and then click “Next”.
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2. macOS: The method is applicable to macOS environment. If you are using 
macOS Catalina, please update to at least 10.15.4.

a. Install the Ethernet cable :
Install both ends of the Ethernet cable in the network slot on the back of the 
machine and in the computer network slot.

b. Verify the machine network :
Verify that the machine has a value for Wired Network “MAC Address” in “NET-
WORK” page.

c. Turn off the computer firewall:
“System Preferences” > “Security & Privacy” > “Firewall” > “Turn Off Firewall”.

d. Enable Internet connection sharing :
“System Preferences” > “Sharing” > Set the “Share Your Connection From” to the 
network you are using (Wi-Fi or Ethernet) > Select the port to use > Click “Start” 
on the pop-up message to enable the sharing.
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e. Set the IP address of your computer to 192.168.2.1 :
Click the network icon in the upper right corner, select “Open Network Preferenc-
es” > select the interface intended to use (RJ45 adapter) > Select “Configure IPv4” 
as “Using DHCP with manual address” > And set the “IPv4 address” to 192.168.2.1.

Connection Settings 

CH 2-5
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If you have previously skipped setting the connection method, you 
can go to the setup screen to set the IP via “Machines” > “Machine 
Setup” in the menu.

【Troubleshooting】Connection Issue ( p.215 ) 

Once the connection is complete, 
you can start your first engraving!

g. Membership Login :
Login to the membership, you can access more functions added to the software 
from time to time in the future. 

h. Select the connection method :
Select “Direct Connection”.

f. Set the software interface display language :
Use the drop-down list to select the language, and then click “Next”.

i. Enter the IP address of the machine to complete the setting:
Confirm the “Wired IP” address of the machine from the panel. Enter the wired 
IP address of the machine into the computer to complete the setting. It usually 
starts with 192.168. (If it starts with 169.254, it means the computer may be set up 
incorrectly or the network cable needs to be plugged in again).
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Beam Studio
Tutorial

Chapter Highlights: Camera Calibration, 
Engraving Material Focusing, Common 
Software Functions.
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1. Automatic error return :
When an error is encountered, agree to automatically upload the information 
to the development team to help the team identify potential problems with the 
software.
Note: If you encounter an error alert window in the future, you still need to access 
the bug report to the development team.

2. Camera Calibration :
Calibration of camera and engraving position consistency to ensure accurate 
machine engraving result.
Preparation Items : A4 (Letter size) white paper (self-preparation)
Note : 1. When using the camera preview function for the first time out of the box, 
camera calibration is required first. 2. Each time you use it, you need to focus on 
the engraving material (confirm the focus).
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a. Select Device : Select the name of the machine in use.

b. Place white paper : Place clean A4 (Letter size) white paper in the upper left 
corner of the working area.
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For auto focus, double click the side button of the add-on to make the probe 
touch the engraving material.

c. Focusing : For manual focusing, loosen nozzle fastening ring and make the focus 
probe touch the engraving material, and tighten the ring and turn back the focus 
probe after completed focusing.

Beam Studio Tutorial

CH 2-6
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d. Draw calibration image : the machine will cut out grid lines on the paper.

e . Place the red square : After clicking anywhere to cancel the prompt, move the grid 
lines to the center, align the outside of the red square with the center square of the 
grid lines by adjusting the directional keys, horizontal and vertical translation, rotation 
angle, and size ratio (keyboard up and down keys can adjust the value).
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f. Camera calibration completed : After the camera calibration is completed, the 
first engraving can be started.

e-1. Red square adjustment completion position.

Beam Studio Tutorial

CH 2-6
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3. Beam Studio Tutorial : After completing the Beam Studio tutorial, users can carve 
round and square shapes out from the wood piece.

Steps : 
0. Select "Yes" if you would like to start the Beam Studio tutorial. 

1.  Switch to Preview Mode : Tap the Camera Preview icon on the left > Select the 
 machine in use.

2. Preview the Platform :
a. Put the wood piece
b. Adjust the focal
c. Close the door cover
d. Preview the range of engraving material : click on the working interface or 
    select a preview range

3. End Preview Mode : Select “End Preview”              。

First cut the inner object a

Then cut the outer object b

Preparation Items : Engraving Material: 3mm wood piece (included in the accessory 
box).
Note - To ensure that the engraving results are not affected by the order of 
execution, there are two recommendation :
1. Engraving before cutting : the order of work execution is from the top to the 
bottom of the layer, make sure the engraving layer is on top and the cutting layer is 
on the bottom to avoid the wrong focus of engraving caused by the collapse of the 
object after cutting, which will affect the engraving result.
2. As shown below, if there are multiple cut objects in the same layer, and there is 
an inner and outer relationship, then the inner objects will be cut first, and then the 
outer objects will be cut; if object a is in object b, then object a will be cut first and 
then object b.
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4. Draw a Rectangle : Select a “Rectangle (M）”             to draw a square in Layer 1 
and press Shift to square it.

5. Drag to Draw : Drag to draw a square in the working interface.

6. Switch to Layer Panel : Switch to the layer             to set the parameters.

12. Switch to Layer Panel : Switch to the layer             to set the parameters.

13. Set Preset : Wood - Engraving : “Wood - Engraving”.

14. Send the File            :

a. Confirm the parameters and layer settings.
b. Select the name of the machine in use.
c. Click “Start” to execute the engraving and cutting process.

【Troubleshooting】“Cooler Off” (p.187), “Door Opened” (p.189), “Homing 
Failed”(p.197), etc.

9. Draw a Circle : Select “Oval (L)”             to draw a circle in layer 2 and press Shift 
to make a circle.

10. Drag to Draw : Drag to draw a circle in the working interface.

11.  Turn on Infill : Turn on the infill function.

7. Set Preset : Wood - Cutting : “Wood - 3mm Cutting”.

8. Add a New Layer : The new layer name is Layer 2.

- * If you have already skipped Beam Studio tutorial, you can find the 
tutorial under “Help” > “Show Start Tutorial”.

- If the engraving result is blurred or the color is light, please check 
the focus first. If the foregoing does not work, we recommend 
inspecting or adjusting the optical path. See 【Maintenance】 
“Optical Path Inspection” (p.146), “Optical Path Alignment” (p.148).

Beam Studio Tutorial
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Software 
Interface

This chapter introduces the software 
features and demonstrates the 4 creation 
techniques, including Beam Studio 
creation, importing work files, Trace 
Image, as well as mass production, and 
concludes with formatting instructions. 
Available for Beam Studio 1.7.X.
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The software interface can be divided into 5 sections

A : Toolbar

B : Layer and object management

C : Parameter Settings

D : Working Interface

E : Menu

A

D
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B

E

C

Software Interface
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A：Toolbar

Select specific objects.

Select (V)

Text (T)

Polygon

Rectangle 
(M)

Oval (L)

Add new texts. When 
the Infill is not on, there 
is only a text stroke, 
once it is on, text will 
be solid.

Draw polygons. The number of polygon vertices 
can be increased or decreased by using the "+" and 
"-" keys of the keyboard while drawing.

Press and hold the keyboard Shift :
Able to draw squares and circles from Rectangle (M) and Oval (L).
Able to rotate drawing objects and texts (except importing files) 45 
degrees, and scale one drawing object or text at a time.
Adjust import files freely (scale by default). 

Draw rectangles. 
Able to adjustable 
rounded corners 
radius.

Draw ellipses.

Image (I)

Import JPG / PNG / SVG / DXF / AI / PDF files 
and drag and drop them directly into the soft-
ware or paste them directly from the browser 
after "Copy image".

Line (\)

Draw line paths.
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Pen (Ｐ)

Outline the lines and curves of the vector and adjust the 
shape with the anchor point after you finish drawing.
Press and hold the left mouse button while drawing : Able to 
draw curves. Double click the end point or use the keyboard 
esc to end the pen path. Double click the pen drawing path 
to edit the path.

There are 3 modes according to the node type :

tCorner :
When adjusting the length of one side of the 
handle, only the path on that side will change. 

tSmooth :
When adjusting the length of one side of the 
handle, the path will change on both sides of the 
selection point, but the path will change more on 
the controlling side.

tSymmetry :
When adjusting the length of one side of the 
handle, the path on both sides of the selection 
point will change, and the change is symmetrical.
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Camera Preview Function

Select the name of the machine in use and deliver the task.

Camera Preview :
Preview the range of engraving materials. Click 
or select a range to preview the location of the 
materials to be engraved.

Trace Image :
Scan and convert a pattern to vector grahpics 
for software editing via camera preview.

Clear Preview :
You can delete the images previewed by the 
camera, but the objects of the Trace Image will 
not be deleted.
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Click to turn off the layer.

Right-click on the layer column is able to do the following :  
Duplicate Layer : Duplicate the objects and parameters of the layer and add 
a new layer on the list top.

B：Layer and object 		
	  management
Layer management and object management. Object management not only covers 
the functions shared by picture, text, and drawing objects, but also have their own 
adjustable OPTIONS and ACTIONS. The introductions are as below.

Layer management :

Add Layer

Layer Color

Move elements to

Create and name a 
new layer.

(Next page)

After changing the color, open “View” > “Use Layer Color” to distinguish the 
color of objects between different layers. When displaying layer colors, the 
software performance and editing speed may be affected if the shapes are 
complicated or numerous.

When there are multiple layers, you can transfer 
the selected object to a certain layer in the drop 
down list.

Show Layer

Software Interface
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Lock Layer : You cannot edit the layer objects after locking it, but you 
can rename, delete, move, and merge the layer.
Delete Layer : Delete the layer.
Merge Down : After merging, the layer name will be the name of the 
next layer.
Merge All : After merging, the layer name will be the name of the bottom 
layer.
Merge Selected Layers : After merging, the layer name will be the name 
of the last selected layer (labeled by a blue mark in front).
Delete multiple layers at the same time : Press the keyboard Shift and 
select the layer you want to delete, then use the right-click delete or 
keyboard delete key to delete the selected layers.
Drag and drop the layer to adjust the layer order.

Object management : shared functions for picture, text, and drawing objects.

Horizontal Distribute

Vertical Distribute

Middle Align

Top Align

Left Align

Bottom Align

Distribute the selected objects 
evenly by the center of the graphs 
in the horizontal direction.

Distribute the selected objects 
evenly by the center of the graphs 
in the vertical direction.

Align all the selected objects to the 
middle vertically.

Align all the selected objects to the 
top bounding of the objects.

Align all the selected objects 
towards the leftmost bounding of 
the objects.

Align all the selected objects to the 
bottom bounding of the objects.
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Center Align

Subtract

Right Align

Align all the selected 
objects to the center 
horizontally.

Delete the overlapping 

parts of the two closed 

vector graphics. If two 

vector graphics are 

on the same layer, the 

pattern will be subtracted 

to keep the last drawn 

part; if two vector shapes 

are on two different color 

layers, the pattern will be 

subtracted to keep the 

upper layer and the color 

will be the selected (blue 

marked) layer color.

Align all the selected objects towards the rightmost 
bounding of the objects.

Group

Intersect

Ungroup

Difference

Union

Group multiple 
objects together.

Keep only the part of multiple closed vector graphics 
that overlap. If two vector shapes are on two different 
color layers, the color of the pattern kept will be the 
selected (blue marked) layer color.

Cancel the grouped 
objects.

When Infill is on, only the un-overlapped parts of 
multiple closed vector graphics are kept. If two vector 
shapes are on two different color layers, the color of 
the pattern kept will be the selected (blue marked) 
layer color.

Combine multiple 
closed vector 
graphics into one.

Coordinate

Object coordinate on the working interface.
Center point : Oval Two endpoints : Line
Top left point of the bounding box : Image, Rectangle, Polygon
Top left point of the highlight range : Text

Software Interface
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Gradient

Threshold brightness

When importing bitmap graphics, images are converted to grayscale and 
gradients are turned on by default.

This function defines the RGB color compo-
nents on a scale from 1 to 255, with 1 being 
black and 255 being white. If the threshold 
is set to 125, all colors above 125 will be con-
verted to white and below to black. Move 
the slider to clear the noise and enhance 
the contour.

Lock Horizontal Flip

Vertical Flip

Click to open or close the lock.
Lock opened : press and hold the 
keyboard Shift to scale the select-
ed objects.
Lock closed : press and hold the 
keyboard Shift to enlarge or reduce 
the sizes of selected objects freely.

Flip the selected object(s) accord-
ing to the horizontal line through its 
(their) object center.

Flip the selected object(s) accord-
ing to the vertical line through its 
(their) object center.

OPTIONS:

If the Gradient is turned off, the 
Threshold brightness can be 
used to adjust the binarization 
threshold.

Rotation Angle

Adjust the angle of the selected 
objects.

Adjust the size of an object, W is its 
width and H is its height.

Object Size
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If the Gradient is turned off, the Threshold brightness can be used function to 
adjust the binarization threshold.

Software Interface
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Font

Style

Size

Line
spacing

Rounded 
corner

Letter
spacing

Apply any fonts installed in the operating system to a Text.

Different font-styles are available with different font installed in the operating 
system, as bold, Italics, etc.

Set the Text size.

Set the space between adjacent 
lines of type.

Round the corners of a Rectangle.

Set the space between letters.

Create vertical scripts.

Vertical 
text
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Infill

Fill the blank areas of texts or closed vector graphics 
with color, often used for 
engraving.

Software Interface
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Delete Multiple Objects at the same time : Delete after selecting multiple 
objects.

: Infill of Multiple Objects : When the selected objects do not contain an image 
  and there are more than 2 drawn closed vector graphics, you can select multi-
  ple objects at the same time and perform the Infill function.
   Infill of Pen : When the pen path is a closed vector graphic, the Infill  function 
  can be used.
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Discontinuous paths are "single" paths made up of 
a Pen, or several closed vector graphics being pro-
cessed by Union, Subtract, Intersect, or Difference. 
Decompose is to dissolve a single discontinuous 
path into multiple paths.

Convert to Path

ACTIONS :

Replace With…

Decompose

Trace

Change an image to a new selected 
image from the computer file.

Convert a binary image to a vector 
path. The more complex the pattern, 
the longer the conversion time.

Grading Crop Sharpen

Adjust image bright-
ness and contrast. 
Tap the middle of 
a line segment to 
create an adjustment 
point.

Remove unwanted 
content. Drag any 
edge of the crop box 
to adjust its size.

Convert a Text to 
paths for editing.

Sharpness : Enhance 
the edge contrast 
of an image in an 
attempt to improve 
its acutance.
Radius : If Sharpness 
has a value, you can 
move the slider to 
remove noises.
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Bevel

Invert

Array Offset

Create a blurred grayscale gradient for edges of bitmap graphics. Bevel is often 
used to smooth out engraving depth differences.

Reverse the color of an image, such as negative effect. When engraving trans-
parent materials (such as acrylic), Invert is usually needed to be turned on.

Create concentric objects at a cus-
tom distance inward or outward.

Software Interface
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Copy a large number of objects. 
The number of rows (horizontal 
direction), the number of columns 
(vertical direction), and the object 
spacing (The spacing is the distance 
between centers of two objects.
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: Trace of Image : Only binary images can be converted to vector paths (one 
at a time). Grayscale images are not allowed to do Trace.
Offset of Multiple Objects : When the selected objects do not contain an im-
age or a Text, and there are more than 2 drawn objects, you can select multiple 
objects at the same time and perform the Offset function 
Offset of Text : When the text has been converted to path, the Offset function 
can be used.
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C：Parameter Settings

Import

Manage Add current parameters

The suggested 
parameters for 
common materials 
can be found in the 
drop-down list.

Export

Import all engraving 
parameters stored 
in a .json file into 
the parameter list.

Browse all parameters, and edit or 
delete customized parameters.
“Z STEP (mm)” : When performing 
multiple cuts of the same path for 
a single layer (“EXECUTE” > 1), you 
can set the descending amount of 
the laser head for each execution to 
cut thicker materials. This setting is 
only available for autofocus add-on.

Name the current parameter and 
save it to the parameter list.

Power (%) : the percentage of laser 
output power.
Speed (mm/s) : the number of mil-
limeters per second the laser head 
moves.
Execute (times) : the number of 
times a single layer is executed for 
the same job. 

Export all parame-
ters as a single .json 
file.

Software Interface
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Since there are various materials, for the first time, you can choose the 
built-in parameters to observe the engraving results and then fine-tune 
them to achieve the desired effect.
It is recommended that the power setting be less than 70% to reduce 
laser tube consumption.
The decline of laser tube caused by usage and time is normal, and the 
parameters should be adjusted according to the situation.

Select 
parameters
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D：Working Interface

Zoom in or zoom out the working interface

The center of the window is the area for importing images or drawing objects. Note 
that objects should be placed in the area to proceed the task.

E：Menu

The menu will explain the frequently used functions in each tab.

Beam Studio - About Beam Studio, Preferences ...

Preferences : Modify default settings such as language, machine IP address, 
and add-on. 

－  100%  +

File - Open, Save, Save As, Examples, Export To ...

Examples : Use examples, including different files and material engraving tests 
(different power speed combinations to find out the suitable parameters for 
new materials). 
Export : Export files to several formats, including BVG, SVG, PNG, JPG, FLUX 
task. Detailed information is explained in this chapter on file formats.
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Edit - Optimize, Document Settings, Clear Scene ...

View - Show Grids, Use Layer Color ...

Machines - Test Network Settings, Calibrate Camera for machines connected 
to this network, Update Firmware ...

Window

Help - Show Start Tutorials, Bug Report, Debug Tool ...

Optimize : Optimize the object arrangement, so that the engraving material 
can be used more effectively.
Document Settings : Adjust the engraving resolution, working area (select the 
model), and add-on switch.

Show Grids : Display the grids in the working interface.
Use Layer Color : Show the layer color on objects in that layer.

Test Network Settings : Check the quality of the network connection between 
the computer and the target machine.
Update Firmware : Download the firmware from the official website and save it 
on the computer, then change the machine firmware to the selected version by 
selecting the firmware file on the computer. Note: It takes a few minutes to up-
grade the firmware, so do not turn off the machine in the middle of the process.

This is the default menu for Mac systems; Windows and Linux Ubuntu do not 
have this option.

Bug Report : Export a bug report after an error is encountered. Please mind 
that the software cannot be reorganized or shut down before exporting a bug 
report. Customer Service guides the export of bug report files to troubleshoot 
Beam Studio errors.
Debug Tool : An interface for developers to debug software issues. 

Software Interface
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Four Creation 
Techniques

This section contains Beam Studio 
creation, Import Image, Smart Trace, 
and mass production operation steps.
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Beam Studio is designed for FLUX laser engraving machines, which can effectively 
interface with other professional design software 
(see Appendix II 2-1 Design Software Recommendations) for laser engraving; if there 
are more complex objects and shapes to be engraved, it is recommended to use the 
method of Import Image, and after importing the drawings, final layout and param-
eter settings are made in Beam Studio.
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Four Creation Techniques
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When previewing the Smart Trace image, make sure the least amount of preview is 
done to avoid the misalignment of the image caused by stitching. If the tracing image 
is small, you can click the center of the image to place it in one camera preview screen 
when previewing. 

After confirming the position of the fixture and objects in the first editing of mass 
production project, FLUX task can be exported to the USB flash drive. In the future, 
you only need to insert the USB flash drive into the machine, focus on the engraving 
material on the fixture, and then click "START" page to select the file and directly start 
the engraving job.
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File Formats

There are two main types of digital 
image files, bitmap files and vector files.
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File Formats
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It is essential to use the vector format when cutting. The next 
page will contain a table explaining the file type of import image 
and the file type of saving, etc. There is also an overview of the 
layer layering method and the engraving resolution.

Bitmap is an image type that consist of 
numerous square pixels. Bitmap files are 
rich in details which are mostly suitable 
for photography or digital applications. 
However, the quality is related to the 
resolution so the image can get jagged 
or blurry when resized. 

Suitable for infill engraving

Long working time

Complete image quality

JPG / PNG are commonly used bitmap 
format

AI / PDF / SVG are commonly used 
vector format

Short working time

Clear contour

Suitable for outline engraving and 
cutting

Vector images are composed of paths 
defined by multiple points and are es-
pecially suitable for logos and font lay-
out. For each path, curve, or shape has 
its own formula, and can therefore be 
resized without affecting the graphic 
quality.

Bitmap 
Graphics

Vector 
Graphics

1 2
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File import and export formats :

.bvg / FLUX file (.fc) / .beam is a special file format saved by Beam Studio. If a file 
contains a bitmap, the software will export it to the bitmap preview quality in a .bvg 
file, while saving it as a .beam file will preserve the original image resolution.

*FLUX work : .fc file. .fc file is a machine-readable file that saves the software values 
as object layout, power, etc. This file format cannot be reimported into Beam Studio 
for editing and is often used for mass production work using fixture positioning.
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1.  Layer : If you have set up layers in external software, you can choose this layering 
 method.

2. Color : If there are objects of different colors in the file, you can choose  this layer-
ing method, and the software will create layers according to different colors.

3. Single Layer : If there is no need to set different power and speed, you can choose 
Single Layer, and the software will merge all layers into a single layer.

Layering : You can set the layering style by “Layer”, “Color”, or “Single Layer” when 
importing SVG files in Beam Studio.

Engraving Resolution : In Beam Studio, you can set the engraving resolution, i.e., 
engraving fineness, from low to high, at 100, 250, 500 and 1000 DPI by menu > Edit > 
Document Settings. High resolution engraving result can show more details but take 
longer time, on the contrary, low resolution engraving result is simpler but takes less 
time to complete.  It is recommended to choose the suitable engraving resolution 
according to the creation needs and time consideration.

File Formats
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New Materials Testing
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When new materials are used, 
different combinations of speed 
(S: Speed) and power (P : Power) 
can be used to find the appropriate 
parameters for the material. Sam-
ple files can be imported through 
“Menu > File > Samples > Material 
Engraving Test”, in addition to en-
graving combinations, cutting test 
files are also available.

Thin material (thickness less than 0.5 mm) whether engraving 
or cutting, it is recommended to start the test from high speed 
and low power (e.g., P:20, S:300), and it is not recommended to 
use the sample file for trial to avoid excessive burning resulting 
in oversized engraving or cutting openings.
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Material 
Introduction

In this chapter, we will introduce the char-
acteristics, advantages and disadvantag-
es, and possible solutions for each of the 
8 types of materials and conclude with a 
comparison of the characteristics of the 
same thickness materials.

Read and observe the following instructions and caution carefully.
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Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

New Zealand dense board

Asia dense board

Photo

Photo

Suitability

Suitability

Caution

Caution

1.  Good material stability 
    and easy to cut
2. Low surface embossing 
    impurities

1.  Engraving only, not easy 
    to cut
2. Black dust produced by 
    engraving is relatively high

Lower density than Asian 
dense board

Low price

It is recommended to buy low formaldehyde fiberboard to 
avoid inhaling ingredients that are harmful to health

Overall : glued and pressed wood fiber

It is recommended to buy low formaldehyde fiberboard to 
avoid inhaling ingredients that are harmful to health

1. Wood - Fiberboard, also known as dense board, MDF : 

Material Introduction

CH 4-2
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Overall: Surface: solid wood / Interior: glued and pressed wood fiber.

1. Wood - Plywood :

Teak plywood

Yound wood plywood

Engraving results are 
slightly blurry due to 
lower material density

1.  Mild wood, fine grain, easy to 
    work
2. Light white, straight grain
3. Light material, suitable for making 

crafts with low density, as well as 
children's toys

4. Easily engraved with a slight 
blur, even color after engraving, 
the edges are not easily scorched 
and broken

Higher power required for 
cutting

Beautiful synthetic material

It is recommended to buy low formaldehyde fiberboard to 
avoid inhaling ingredients that are harmful to health

It is recommended to buy low formaldehyde fiberboard to 
avoid inhaling ingredients that are harmful to health 

Material

Advantages Disadvantages

Photo

Caution

Material

Advantages Disadvantages

PhotoSuitability

Caution

Suitability
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Engraving results 
are slightly blurry 
due to lower ma-
terial density

White Russian 
basswood plywood

Plain plywood

Texture quality is poor, 
slightly rough

1. More complex material, hard 
   texture, less likely to break 
   when cutting
2. Used in various building 
    materials or crafts

1.  Mild wood, fine grain, easy to pro-
 cess, strong toughness, not easy to   
 crack and deformation

2. Creamy white, with fine grain 
and low blur density, straight grain 
carving is easier to show a slight 
blur after sanding, staining, and pol-
ishing, can obtain a smooth surface

It is recommended to buy low formaldehyde fiberboard to 
avoid inhaling ingredients that are harmful to health

It is recommended to buy low formaldehyde fiberboard to 
avoid inhaling ingredients that are harmful to health

Material Introduction

CH 4-2

Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

Photo

Photo

Suitability

Suitability

Caution

Caution
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Walnut plywood

Solid wood

Growth rings are easily shown 
while engraving

Diverse and natural 
texture performance

Engraving effect 
is not obvious due 
to the dim color

1.  Mild wood, fine grain, easy to  
process, strong toughness, not 
easy to crack and deform

2. Coffee color, with fine grain and  
    straight grain of different shades.
3. Smooth surface by sanding, stain-
    ing and polishing

Growth rings are a normal representation of uneven 
wood density

Natural, healthy, non-toxic, eco-friendly.

1. Wood - Solid Wood :

Material

Advantages Disadvantages

PhotoSuitability

Caution

It is recommended to buy low formaldehyde fiberboard to 
avoid inhaling ingredients that are harmful to health

Material

Advantages Disadvantages

PhotoSuitability

Caution
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Problem Solution Possible Drawback

Polyurethane (PU)

Color Shades
1.  Deepen the color : 
    lower the Speed
2. Deepen the cutting depth : 
    increase the Power

1. Use wood with lower density
2. Clean with a small amount 
    of alcohol

1. Wood is easily deformed by 
   moisture
2. Excessive alcohol causes 
    tar to penetrate into the wood

Before processing
1.  Cover the surface of the engraving  
    material by paper tape
2. Slightly wet the wood 
After processing
1. Remove the burn marks with 
   sandpaper

Before processing
1. Tape residue stays
2. Bumps are created on the 
    surface
After processing
1. Scratch marks appear

1. Burn marks grow
2. Fineness decreases and 
    distorted proportion occurs

Engraving 
Burn Marks

Cutting 
Burn Marks

1.  Base cloth: PU looks much thicker 
    than PVC from the edges
2. Texture: PU feels softer than PVC

Incomplete burning will produce toxicity

_

Base layer: mostly woven fabric; adhesive layer; resin layer: PU and PVC, etc

2. Leather - Synthetic Leather :

Common Wood Problems :

Material Introduction

CH 4-2

Material

Advantages Disadvantages

PhotoSuitability

Caution
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Vegetable tanned leather

Original color, easy to absorb oil 
and moisture, firm

Mild, soft, elastic

2. Leather - Genuine Leather :

_

_

Polyvinyl chloride (PVC)

The gas produced by engraving 
is corrosive and will cause the 
screws in the machine to rust

Hazardous materials

_

Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

Photo

Photo

Suitability

Caution

Caution

Suitability
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Chrome 
tanned leather

Flexible, water and stain 
resistant, not easy to fade _

Toxic gas will be generated when burning, not suitable 
for laser processing

Scorched and 
curled

Before processing
Wet the whole piece 
of leather

Use with an air filter Air filter foam sheet is consumable

Leather wrinkles after drying

Heavy smell of 
laser processing

Common Leather Problems :

Material Introduction
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Material

Advantages Disadvantages

PhotoSuitability

Caution

Problem Solution Possible Drawback
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Scratches
After processing
Use special plastic abrasive 
to remove scratches

Some acrylics contain more 
impurities, we suggest to use 
better quality acrylics.

Big price difference between first 
grade acrylic and second grade 
acrylic

1.  Keep the acrylic protective 
 film when not engraving  
 gradient images

2. Clean with a small amount 
of alcohol

Some acrylics with too much al-
cohol will cause surface defects, 
such as cracks. But gently heating 
acrylic may help repairing the mi-
nor cracks.

Only remove shallow scratches

Cloudy acrylic

Bursting sound 
when cutting

Common Acrylic Problems :

Acrylic

Easy to produce dust during 
processing

There will be no burn marks 
after laser processing

Make sure that the material is not plastic (PVC, PC)

Strong, tough, durable

3. Acrylic - Acrylic, also known as PMMA, plexiglass, poly (methyl methacrylate): 

Material

Advantages Disadvantages

PhotoSuitability

Caution

Problem Solution Possible Drawback
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White paper

Corrugated cardboard

_

_

Widely available

Easy to obtain, and does 
not require high power 
to process, suitable for 
structural works

Warps will form when burn-
ing papers at high tempera-
tures, so make sure the pa-
per is fixed

Uneven surface, need 
to pay attention to the 
focus position

Widely available

Cheap, strong structure, suitable for three-dimensional art pieces

4. Paper - White Paper: 

4. Paper - Corrugated Cardboard :

Material Introduction
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Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

Photo

Photo

Suitability

Suitability

Caution

Caution
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Yellowish 
carbonized 
burn edges

Before processing
Paper material will affect the amount 
and color of the ashes, it is recom-
mended to use paper with PP mate-
rial.
After processing
Use low-viscosity material, such as 
universal clay, to remove the toner.

Before processing
Slightly wet the corrugated card-
board

Paperboard is more 
likely to be deformed 
(uneven)

Burning of the 
downward layer

_

Common Paper Problems :

Glass

Easy to produce glass 
chips during processing, 
and different engraving 
results depending on the 
glass material

Easy to obtain, such as 
beverage bottles and cans

5. Glass :

_

Problem Solution Possible Drawback

Material

Advantages Disadvantages

PhotoSuitability

Caution
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Cracked 1. Choose thick glass
2. Reduce Power

Some glass material itself will be 
cracked by laser processing, which 
is a material characteristic and can-
not be avoided

Common Glass Problems :

Anodized aluminum alloy

Engraving effect is 
obvious with low power 
and no color loss

The metal material can reach high temperatures after the 
laser process. However, it can be quickly cooled down 
within a minute

Blurred pattern or even 
brown color may be 
produced while using too 
much power

Wear-resistant and textured

6. Metal - Anodized Aluminum Alloy Surface : 

Material Introduction
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Problem Solution Possible Drawback

Material

Advantages Disadvantages

PhotoSuitability

Caution
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Stainless steel
after oxidation

Easy to engrave stain-
less steel by spraying 
the special spray evenly 
before processing

The engraving result is not 
too fine and is only suitable 
for artistic creation and 
entry experience

6. Metal - Special Spray Oxidized Stainless Steel :

Stone

_

Depending on the stone, 
materials that more suitable 
for surface engraving are 
shales and marbles

Engraving effect is 
usually not obvious when 
using stones with lighter 
colors

There are differences between artificial materials and natural materials, and the 
textures are diversified.

7. Other Engravable Materials - Stone :

Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

Photo

Photo

Suitability

Suitability

Caution

Caution

1.  Oxidize the stainless steel with Steel Engraving Spray 
 before engraving

2 . It is recommended to wear gloves when using the spray 
to avoid staining the skin

3. The metal material can reach high temperatures after the
laser process. However, it can be quickly cooled down 
within a minute
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Cement

_

Textures can be easily creat-
ed on the cement surface

Particle size of cements 
will affect the overall 
engraving result

7. Other Engravable Materials - Cement :

EVA foam

_

Can cut with extremely low 
power and not easy to pro-
duce burn marks

Need to keep good ventila-
tion because pungent odor 
will be produced while en-
graving and the material is 
more flammable

7. Other Engravable Materials - EVA Foam :

Lightweight and low density, commonly used in molds and cushioning materials

Material Introduction
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Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

Photo

Photo

Suitability

Suitability

Caution

Caution
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Silicone

Cotton and 
linen fabric

Necessary to increase the cleaning frequency of the re-
flective mirrors to avoid them from sticking to the dusts 
and affecting the laser output

_

Eco-friendly, 
non-toxic

Can engrave with low power

Instantly be hardened when heated, 
so it is not suitable for cutting, if you 
need to cut, it is recommended to 
use scissors or blades

Need to keep good ventila-
tion because pungent odor 
will be produced while en-
graving and the material is 
more flammable

7. Other Engravable Materials - Silicone :

7. Other Engravable Materials - Cotton and Linen Fabric :

Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

Photo

Photo

Suitability

Suitability

Caution

Caution
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Engraving is 
not visible

Increase Power and 
repeat engraving

Clean with a toothbrush Consumption of toothbrush

Cut with other tools : 
scissors, utility knife Shapes are not identical

Possible to get crude results

Difficult to 
cut off

Silicone is dusty 
after engraving

Other Engravable Materials - Common Silicone Problems :

Polyvinyl chloride (PVC)

_

Highly carcinogenic substances and health hazardous and 
corrosive gas may be generated when burned

Prone to have jagged melt-
ing marks on the edges

Usually appears as stickers, thin films, or transparent slabs, for example, cutting 
sheets

8. Hazardous Materials - Polyvinyl Chloride (PVC) :

Material

Advantages Disadvantages

PhotoSuitability

Caution

Problem Solution Possible Drawback

Material Introduction
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Acrylonitrile butadiene
styrene (ABS)

Plastics with chlorine, benzene, 
ammonia, fluorine, phenol, alde-
hyde in its scientific name or with 
a hexagonal benzene ring in its 
molecular formula

_

_

_

_

Carcinogenic substances may be generated when 
incompletely burned

Carcinogenic and toxic substances are highly 
possible to be generated when burned

Take resin identification codes for example, the following 
numbers are not suitable for engraving process :

Hexagonal 
Benzene Ring

8. Hazardous Materials - Acrylonitrile Butadiene Styrene (ABS) :

8. Hazardous Materials - Plastics with Chlorine, Benzene, Ammonia, Fluorine, 
Phenol, Aldehyde in its Scientific Name or with a Hexagonal Benzene Ring in its 
Molecular Formula :

Material

Material

Advantages

Advantages

Disadvantages

Disadvantages

Photo

Photo

Suitability

Suitability

Caution

Caution
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Comparison of 
materials of the 
same thickness

Wood

Easy Easy

Strong

Medium

MediumMedium

Much

Much

Less Less

Less LessMuch

Medium

Medium

Strong Faint

Easy Difficult

No

No No

Difficult

*Faint

* : metallic dusty smell

PaperLeather Glass MetalAcrylic

Processing difficulty

Strength of smell

Amount of tar

Dustiness

Gradation effect

Reflections from the 
material itself, e.g. 

glossy metals

Avoid using, except for spray 
oxidized stainless steel

Pad the material and Dis-
tance the material from the 
honeycomb table to avoid 
burn marks on the material 
from laser reflections

Reflections caused by 
the laser penetrating 

the material and hitting 
the honeycomb table

Common Problems :

Material comparison :

_

_

The above comparisons are based on common materials, and 
the actual engraving effect is subject to your own test results.

Material Introduction
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Problem Solution Possible Drawback
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Maintenance

To facilitate maintenance and repair 
instructions, this section divides the 
machine into three general areas: the 
panel, the working area, and the back 
cover.
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Maintenance

CH 5-1

Maintenance of the machine according to the maintenance frequency can effectively 
reduce the chance of failure.
【Appendix 3】 Maintenance Checklist (p.252) provides maintenance record sheet 
for users to use. 

* : Necessary maintenance

Area Maintenance Content Maintenance Frequency

MAINTAIN page * Once every 1 month

Screen cleaning Once every 2 weeks

Lubricatingt* :

Once every 2 weeks

Honeycomb table cleaning Once every 2 weeks

- Wood, Plywood

Chassis cleaning Once every 2 weeks

- Acrylic Once every 1 week

Mirrors and lens cleaning* Once every 1~2 weeks

- Leather Once every 2 weeks

Optical path inspection*
When first unboxing, 
after laser tube replace-
ment Once every 1 month

- Paper Once an operation day

Laser tube replacement
Depends on power, 
usage hours, room tem-
perature, water tempera-
ture, etc.

Optical path alignment Adjust when the optical 
path misaligned

Water changing and adding* Once every 3 months

Door cover cleaning Once every 2 weeks

Ventilation fan cleaning Once every 1 month

Panel

Working 
Area

Back 
Cover
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Panel

The panel contains the machine inter-
face and the components underneath.
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MAINTAIN Page : 
Function Test

It is recommended to check 
once every 1 month.

Preparation Items : None

Status display

Switches

Panel

CH 5-2

Maintenance Steps : After homing successfully, check the status display and switches 
except for the “Laser Pulse”, and the standards are as follows
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Status display Test method

On

Verify that the water temperature 
is displayed properly
During working, the water tem-
perature should show 5℃-30℃.

Press the “Pump” switch (start 
pump)

Open and close the door cover

Opened Closed

Off

Icon

Water 
temperature

Door cover

Water pump

Y-axis
limit switch

X-axis
limit switch

Not 
triggeredTriggered

After pressing “Motors” to re-
lease the motors, move the laser 
head to the leftmost side of the 
machine until hearing a clicking 
sound. (Trigger switch)

After pressing “Motors” to 
release the motors, move the 
laser head to the backmost side 
of the machine until hearing a 
clicking sound. (Trigger switch)

Not 
triggeredTriggered
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- Pump : Open the back cover to check whether the blue light of the water pump is 
on (as shown below) and whether the water pump icon on the screen is          .     

Panel

CH 5-2

Switches :

- Camera : Check whether the camera view appears on the screen and move the 
laser head to observe whether the screen keeps changing with the camera move-
ment. (Camera view is updated every 3 seconds)

- Motors : Check whether the laser head can move normally along the X-axis linear 
rail and Y-axis guiding rods.

- Air Pump : Check whether there is air coming out of the laser outlet with a piece of 
paper, as shown above.

129
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Cam Led

Work Led

- Ventilator : After clicking, there will be a sound of acceleration and rotation, like 
the sound of aircraft taking off.

- Backlight : The screen will turn black and then light up after clicking.
- TouchSig : The screen will be untouchable for 3 seconds after clicking.
- Cam Led : The light next to the camera, check if it can be normally illuminated, as 

shown below.
- Work Led : At the front side of the chassis, check if the light can be normally illu-

minated, as shown below.
 
If there is any abnormality, please go to 【Troubleshooting】(p.184)  to find the 
solution.
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Screen Cleaning It is recommended to check 
once every 2 weeks.

Preparation Items : Self-preparation : 1｜75%~99% alcohol, 2｜Cleaning cloth

Maintenance Steps : If the screen is dirty, spray a small amount of alcohol on a 
cleaning cloth and wipe the screen lightly.

1 2

Panel

CH 5-2

131
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Working Area

The working area includes the working 
range and the laser optical path.
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1 2 3

Lubricating
It is recommended to clean and 
re-lubricate once every 1 - 2 weeks.

Maintenance Steps : Clean the Y-axis guiding rods, X-axis linear rail and focusing 
mechanism regularly to extend the service life of the parts.

Working Area

CH 5-3

Preparation Items : Self-Preparation : 1｜Paper towel or tissue paper, 2｜Cotton 
swab or brush 
Included in the accessory box : 3｜Lubricating oil

133
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1. Cleaning : Use paper towel or tissue paper to wipe the oil and dust on the Y-axis 
    guiding rods, X-axis linear rail and focusing mechanism.

Y-axis 
guiding 
rods

Y-axis 
guiding 
rods

X-axis 
linear rail

Focusing
mechanism

134

Details of 
X-axis linear rail
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- Y-axis guiding rods and X-axis linear rail : Use at the Y-axis guiding rods on 
both sides of the working range > Apply evenly above and on both sides of the 
X-axis linear rail > Manually move the laser head left and right and forwards and 
backwards 3 - 5 times to distribute the lubricating oil evenly.

- Focusing mechanism : Apply at the top of the focusing mechanism.
Manual focusing: Turn the nozzle fastening ring clockwise > Move the CO2 laser 

module bracket up and down 3 - 5 times and tighten the nozzle 
fastening ring counterclockwise.

Autofocus: Press and hold the side button to raise and lower the mechanism 3 - 5 
times.

Nozzle 
fastening ring

Side button

2. Oiling : Dip cotton swab or brush in the lubricating oil >

135

Lubricating 
position

Lubricating 
position

Manual focusing mechanism

Manual focusing mechanism

Auto focusing mechanism

Auto focusing mechanism

Working Area

CH 5-3
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Honeycomb 
Table Cleaning

It is recommended to clean it once 
every 2 weeks.

1 2 3

136

Preparation Items : Self-preparation : 1｜Vacuum cleaner or brush, 2｜Paper towel 
or tissue paper, 3｜Air conditioner coil foaming cleaner
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Maintenance Steps:

1. Take the honeycomb table out : Move the laser head to the upper left of the 
working range > Reach the front of the machine, lift the honeycomb table up and 
pull it out. As shown in the picture above.

2. Clean the honeycomb table : Use a vacuum cleaner or brush to clean the large 
residue and dust > Spray the honeycomb table with the air conditioner coil foam-
ing cleaner  > Wait for the tar oil to soften, then wipe it with paper towel or tissue 
paper to remove the tar.

3. Put the honeycomb table back : Place the honeycomb table at a 45-degree 
angle into the chassis and lay it flat.

137

Focus probe

Working Area

CH 5-3

Nozzle 
fastening ring

Side button

137

- The mesh part of the honeycomb table is relatively sharp, so please be 
careful when holding.

- If the machine adopts the autofocus version, please press and hold the 
side button (as bottom right picture) to retract the laser head and 
then take out the honeycomb table to avoid hitting the probe.

- If the laser head cannot be moved, please click “MAINTAIN” on the 
screen > “Motors” to release the motors.

Manual focusing mechanism Auto focusing mechanism
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Chassis 
Cleaning

1 2 3

138

It is recommended to clean it 
once every 2 weeks.

Preparation Items : Self-preparation : 1｜Vacuum cleaner or brush, 2｜75%~99% 
alcohol, 3｜Paper towel or tissue paper.



139139

Working Area

CH 5-3

Maintenance Steps:

1. Take the honeycomb table out : Move the laser head to the upper left of the work
ing range > Reach the front of the machine, lift the honeycomb table up and pull it out. 
As shown in the picture above.

2. Clean the chassis : Use a vacuum cleaner or brush to clean the large residue and 
dust, or directly loosen the 4 screws of the bottom cover to remove the bottom cover 
for cleaning > Spray the bottom of the chassis with alcohol evenly > Wipe it with pa-
per towel or tissue paper after a minute to remove the tar.

3. Put the honeycomb table back : Place the honeycomb table at a 45-degree angle 
into the chassis and lay it flat.

- The mesh part of the honeycomb table is relatively sharp, so please be 
careful when holding.

- If the machine adopts the autofocus version, please press and hold the 
side button (as bottom right picture) to retract the laser head and 
then take out the honeycomb table to avoid hitting the probe.

- If the laser head cannot be moved, please click “MAINTAIN” on the 
screen > “Motors” to release the motors.
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Mirrors and 
Lens Cleaning

Depending on the frequency of usage and 
material,it is recommended to clean the 
mirrors and lens once every 1 - 2 weeks.

Preparation Items : 1｜Cotton swab, 2｜75%~99% alcohol

Maintenance Steps : If the engraving material is paper or wood, it is more likely to 
cause dust and tar oil to stick on the reflective mirrors. You can 
use cotton swabs with a small amount of alcohol to clean and 
wipe until the mirror surface is free of stains.

1 2

140
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After cleaning, the mirrors and lens should not be left with water 
marks to avoid oxidation which may have an effect on the laser 
power, and should not be wiped excessively as well.

There are 3 reflective mirrors and 1 focus lens that need to be cleaned in beamo, 
and their positions are shown in the picture.

Maintenance Steps:

1. Clean the first reflective mirror : The first reflective mirror is located at the left 
side of the laser tube facing the chassis. You can open the back cover or wipe it 
from the front hole. As shown below.

141

Working Area

CH 5-3
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3. Clean the third reflective mirror : The third reflective mirror is in the golden 
triangular mirror holder which is on the X-axis linear rail.

2. Clean the second reflective mirror : The second reflective mirror is located on 
the left Y-axis guiding rod facing the chassis.

142
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4. Clean the focus lens : The focus lens is located under the third reflective mirror,  
inside the laser head. 
a. Remove the honeycomb table >

b. Unscrew the nozzle fastening ring clockwise >

143

Nozzle 
fastening ring

Working Area

CH 5-3
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c. Remove the laser head, and turn the silver mounting cap counterclockwise (use 
a pair of needle nose pliers if needed) >

d. Take out the focus lens and then clean it.

144

Silver mounting cap
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If not installed according to the direction of the instruction, it may cause 
inaccurate focus, resulting in blurred engraving or inability to cut.

5. Put the focus lens back : The lens has an orientation, the convex side faces up, 
the flat side faces down.
(Hold the edge of the focus lens on your hand and look towards the focus lens, 
you can see yourself on the convex side and cannot see yourself on the flat side.)

Flat sideConvex side

Working Area

CH 5-3
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Optical Path 
Inspection

When first unboxing, after laser tube 
replacement, once every 1 month.

146

Notes : The optical path will be changed due to transportation and vibration of the 
working, so regular inspection is necessary to ensure the correct laser optical 
path, so that the machine can engrave evenly and cut normally.
Necessary inspection conditions : 1. The first time unboxing after long dis-
tance transportation. 2. After replacement of the laser tube. 3. For regular 
maintenance, it is recommended to check once a month.

Preparation Items : Included in the accessory box : 1｜Double-sided tape

Do not put your finger near the first reflective mirror and the 
aperture (circle outlet) to avoid skin exposure of laser hazard.
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Inspection Steps :

1. Get the laser spots in the two corners : Hit the “MAINTAIN” of the machine > 
Select “Motors” > Move the laser head to the top left position > Put the double-sided 
tape on the laser head outlet > Close the door cover > Make sure the laser “Power” is 
the default x 1.00 > Click “Laser Pulse” > Open the door cover > Make sure the laser 
spot is a full circle > Move the laser head to the bottom right > Put the double-sided 
tape on the laser head outlet > Close the door cover > Click “Laser Pulse” > Open 
the door cover > Make sure the laser spot is a full circle. Get a total of 2 laser spots 
on the top left and bottom right.

147

Working Area

CH 5-3
First reflective mirror

Second
reflective
mirror

Third reflective mirror

Focus
lens

Top right

Middle rightMiddle left Center

Bottom rightBottom left

Top left

X-axis

Y-axis

Z-axis

Unable to get a full circle at both corners, you need to go through 
the 【Maintenance】 Optical Path Alignment (p.148).
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Optical Path 
Alignment

If the optical path is misaligned, the optical path should be realigned.
Signs of misaligned optical path : 1. engraved patterns will be deeper to lighter in a 
certain direction; 2. the cut section is not vertical after cutting.

Once every 1 month

1 2 43

148

Preparation Items : Included in the accessory box: 1｜2.5mm hexagonal wrench, 2｜Torx 
screwdriver, 3｜Double head wrench, 4｜Double-sided tape
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Alignment Instructions :

1. The Y-axis direction is related to the first reflective mirror. After the first reflec-
tive mirror is correctly adjusted, the laser spot got at bottom left position should 
coincide with that got at top left position. When adjusting the first reflective 
mirror, put the double-sided tape on the second reflective mirror.

2. The X-axis direction is related to the second reflective mirror. After the second 
reflective mirror is adjusted, laser spot got at middle right position should coin-
cide with that got at middle left position. When adjusting the second reflective 
mirror, put the double-sided tape on the third reflective mirror.

3. The Z-axis direction is related to the third reflective mirror. After the third re
flective mirror is adjusted, the laser spot should be in the center of the laser 
outlet. When adjusting the third reflective mirror, put the double-sided tape on 
the laser outlet.

1.  Do not open the door cover and  the back cover when laser pulsing is in progress, 
    otherwise the laser will not emit light due to the protection mechanism.
2. When aligning the optical path, the “Power” can be set to x0.50 in the “MAINTAIN” 
    page to avoid the laser spot being too large to judge the laser spot offset direction   
   precisely. When the alignment is completed, the “Power” needs to be restored to  
    the original power setting of x1.00 to avoid insufficient power during use.
3. If there is an abnormal cracking sound when starting the laser pulse, please dis
    connect the power and stop using it immediately. 【Troubleshooting】 No Laser 

    Beam Output. (p.204)

4. Please use the Torx screwdriver to remove the 6 screws on the back cover and then 
    remove the back cover.
5. Since there are threadlockers on the nuts of the first and second reflective mirrors 
    fixing mirror adjustment screws, dropping a small amount of alcohol on those nuts 

    is suggested to soften the threadlockers before turning the nuts.

Working Area

CH 5-3
First reflective mirror

Second
reflective
mirror

Third reflective mirror

Focus
lens

Top right

Middle rightMiddle left Center

Bottom rightBottom left

Top left

X-axis

Y-axis

Z-axis
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Alignment Steps:

Laser tube
Target : To confirm the laser spot is on the first reflective mirror.
Method :
1. Remove the back cover : Please use a Torx screwdriver to remove the 6 screws 

on the back cover and then remove the back cover. 
2. Paste the tape : Take a piece of double-sided tape and paste it on the round 

metal frame of the first reflective mirror.
3. Obtain laser spot on the first reflective mirror : Close the door cover and the back

cover > Click the “MAINTAIN” on the screen > Click “Laser Pulse” > Open the back  
cover > Make sure the laser spot is within the mirror, avoiding the frame of the 
mirror.

If the laser spot is on the frame, it indicates that the optical path is shift-
ed too much, so you need to move the first reflective mirror assembly to 
make the laser spot fall into the mirror. (Use 2.5mm hexagonal wrench to 
loosen the 2 screws on the bottom of the first reflective mirror assembly) 
> Adjust the position of the assembly > Tighten the screws back). If the 
laser spot is weak (laser pulse at screen power x 1.00, it takes more than 
3 shots before the laser spot is visible), then the laser tube should be 
replaced. 【Maintenance】Laser Tube Replacement. (p.163)

150

Reflective mirror

Mirror frame



151

Working Area

CH 5-3

First reflective mirror
Target : To make the bottom left spot coincide with the top left spot. 
Method :
1. Release the motors and paste the tape : Click the “MAINTAIN” of the machine to 

finish the homing  > Click "Motors" > Take a piece of double-sided tape and paste it 
on the metal frame of the second reflective mirror.

2. Obtain the top left laser spot : Move the laser head to the top left manually > Close 
the door cover and the back cover > Click “Laser Pulse” > Open the door cover > 
Confirm the laser spot position. You need to observe how the next (bottom left) laser 
spot moves.

3. Obtain the bottom left laser spot: Move the laser head to the bottom left manually >
Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm whether 
the bottom and top left are overlapped at the same position and avoid the reflective 
mirror frame. As shown in the picture above. If the laser spots are not completely 
overlapped, adjust the mirror adjustment screw behind the first reflective mirror ac-
cording to the direction of laser spot movement, so that the bottom left laser spot 
position moves to the top left laser spot position. 

4. Adjust the first reflective mirror: Remove the back cover > Drop a small amount of
alcohol on the nut to soften the threadlocker > Use a double head wrench to loosen 
the nut without turning the mirror adjustment screw > Tighten or loosen the mirror 
adjustment screw according to the direction of laser spot movement (control direc-
tion explained later) > Repeat steps 2, 3, 4 until the bottom left laser spot overlap 
with the top left laser spot (if you can no longer determine the direction of laser spot 
movement, you need to reapply the double-sided tape) > After finishing the adjust-
ment, tighten the nut without turning the mirror adjustment screw.

After confirming that the bottom and top left spots coincide and avoiding the 
reflective mirror frame, close and fasten the back cover, then adjust the second 
reflective mirror.
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Tightening or loosening screw is equivalent to adjusting the angle of the reflective 
mirror.

- When turning the yellow screw, the red and green screw link can be considered 
as the axis of rotation.
By tightening the yellow screw (clockwise), you can think of pushing the mirror 
from the upper left with the red and green as the axis, and the laser spot will move 
down to the lower right. Loosening the yellow screw (counterclockwise), you can 
think of the red and green as the axis to move the mirror backward in the upper left, 
and the laser spot will move up to the upper left.

- When you turn the green screw, you can think of the yellow and red screw link as 
the axis of rotation.
By tightening the green screw (clockwise), you can think of the yellow and red as 
the axis to push the mirror from the upper right, and the laser spot will move to the 
left. Loosening the green screw (counterclockwise), you can think of the yellow and 
red as the axis to move the mirror backward in the upper right, and the laser spot 
will move to the right.

- When turning the red screw, think of the yellow and green screw link as the axis 
of rotation.
By tightening the red screw clockwise, you can think of the yellow and green as the 
axis to push the mirror from the lower left, and the laser spot will move up. If you 
loosen the red screw (counterclockwise), you can think of the yellow and green as 
the axis to move the mirror backward in the lower left, and the laser spot will move 
downward.

The rotation directions of mirror 
adjustment screws of the first 

reflective mirror.

The moving paths of the laser spots on 
the double-sided tape on the second 

reflective mirror.

Screw Nut

If there is no laser spot at the bottom left, please move to the mid-
dle left for correction first, and then change back to the top left and 
bottom left for correction after confirming that the middle left and 

top left points can be overlapped.
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Working Area

CH 5-3

Second reflective mirror
Target: To make the middle right spot coincide with the middle left spot.
Method:
1. Paste the tape : Take a piece of double-sided tape and paste it on the round 

metal frame of the third reflective mirror.
2. Obtain the middle left laser spot : Move the laser head to the middle left 

manually > Close the door cover > Click “Laser Pulse” > Open the door cover > 
Confirm the laser spot position. You need to observe how the next (center) laser 
spot moves.

3. Obtain the center laser spot : Move the laser head to the center manually >  
Close the door cover > Click “Laser Pulse” > Open the door cover > Confirm 
whether the center and middle left overlap in the same position. You need to ob-
serve how the next (middle right) laser spot moves.

4. Obtain the middle right laser spot : Move the laser head to the middle right 
manually > Close the door cover > Click “Laser Pulse” > Open the door cover > 
Confirm whether the spots overlap in the same position. If they are not complete-
ly overlapped, adjust the mirror adjustment screw behind the second reflective 
mirror according to the direction of laser spot movement, so that the middle right 
laser spot position moves to the middle left laser spot position.

5. Adjust the second reflective mirror : Drop a small amount of alcohol on the nut  
to soften the threadlocker > Use a double head wrench to loosen the nut without 
turning the mirror adjustment screw > Tighten or loosen the mirror adjustment 
screw according to the direction of laser spot movement (control direction is ex-
plained later) > Repeat steps 2, 4 and 5 until the middle right laser spot overlap 
with the middle left laser spot (if you can no longer judge the direction of laser 
spot movement, you need to reapply the double-sided tape) > After finishing the 
adjustment, tighten the nut without turning the mirror adjustment screw.
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6. Confirm the spots of the middle right and the middle left overlap : Take a piece 
of double-sided tape and put it on the golden frame of the third reflective mirror 
> Repeat steps 2 and 4 to confirm the overlap of the middle right and middle left 
spots and avoid the reflective mirror frame, then fine-tune the laser head assembly 
position so that the overlapping spot is located on the perpendicular line of the 
round metal frame (black solid line area in the figure).

154

The rotation directions of mirror 
adjustment screws of the second 

reflective mirror.

The moving paths of the laser spots 
on the double-sided tape on the third 

reflective mirror.

Screw Nut
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4 hexagonal screws

Moving direction

7. Fine-tune the laser head assembly position : Use a 2.5mm hexagonal wrench to 
loosen the 4 hexagonal screws on the X-axis linear rail that hold the laser head 
assembly in place > Move the laser head forward or backward depending on the 
position of the spot > Roughly tighten the 4 screws > Move the laser head to the 
center manually > Close the door cover > Click “Laser Pulse” > Open the door cover 
> Confirm that the spot is on the perpendicular line > Move the laser head to the 
chassis front > Click “Camera” and make sure the upper and lower edges of the 
camera are parallel to the machine chassis > Fix the 4 hexagonal screws of the laser 
head assembly. After confirming that the middle right and middle left spots are on 
the perpendicular line of the round metal frame, you can adjust the third reflective 
mirror.

Working Area

CH 5-3

Nozzle fastening ring
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Third reflective mirror
Target: To make the laser spot hit the center of the laser outlet.
Method:
1. Adjust the height of the laser head : Turn the golden nozzle fastening ring off >

Adjust the height of the laser head so that the focus probe touches the honey-
comb table > Turn the focus probe back > Tighten the golden nozzle fastening 
ring.

2. Paste the tape : Take a piece of double-sided tape and put it on the laser head 
outlet > Gently press the double-sided tape to make a circle of laser head outlet 
indentation on the tape's adhesive surface.

3. Obtain the center laser spot : Move the laser head to the center manually > 
Close the door cover > Click “Laser Pulse” > Open the door cover > Make sure the 
laser spot is in the center of the laser outlet. If it is not in the center of the circle, 
you need to adjust the mirror adjustment screw behind the third reflective mirror 
according to the position of the spot.

4. Adjust the third reflective mirror : Use a double head wrench to loosen the nut 
without turning the mirror adjustment screw > Tighten or loosen the mirror ad-
justment screw according to the direction of the laser spot movement (the con-
trol direction is explained later) > Repeat steps 3 and 4 until the laser spot falls 
in the center of the beam outlet (if you can no longer judge the laser spot move-
ment direction, you need to reapply the double-sided tape) > After finishing the 
adjustment, tighten the nut without turning the mirror adjustment screw.

The adjustment method is different from the first and second reflective mirror, be-
cause the position of the mount under the third reflective mirror is fixed, so when the 
screw is tightened, the mount will not move, but the reflective mirror will be ejected.
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- When turning the yellow screw, the red and green screw link can be regarded as 
the axis of rotation. 
Tightening the yellow screw (clockwise), you can think of moving the mirror back-
ward in the upper right with red and green as the axis, and the laser spot will move 
to the upper right. Loosening the yellow screw (counterclockwise), you can think of 
the red and green as the axis to push the mirror from the upper right, and the laser 
spot will move to the lower left.

- When turning the green screw, the yellow and red screw link can be regarded as 
the axis of rotation. 
Tightening the green screw (clockwise), you can think of moving the mirror back-
ward in the upper left with the yellow and red as the axis, and the laser spot will 
move to the left. Loosening the green screw (counterclockwise), you can think of 
the yellow and red as the axis to push the reflective mirror from the upper left, and 
the laser spot will move to the right.

- When turning the red screw, the yellow and green screw link can be regarded as 
the rotating axis.
Tightening the red screw (clockwise), you can think of moving the mirror backward 
in the lower right with the yellow and green as the axis, and the laser spot will move 
downward. Loosening the red screw (counterclockwise), you can think of the yel-
low and green as the axis to push the reflective mirror from the lower left, and the 
laser spot will move upward.
After completing the above adjustments, you can ensure that the laser beam out-
put is uniform at any location in the working area to achieve normal working re-
quirements. Please perform "Calibrate Camera" again before use. 【Beam Studio 
Tutorial】 Camera Calibration. (p.063)
If the laser beam output verticality is strictly required, you can further adjust the 
verticality of the optical path.

Screw

Nut

The rotation directions of mirror 
adjustment screws of the third 

reflective mirror.

The moving paths of the laser 
spots on the double-sided tape 

on the laser head outlet.

Working Area

CH 5-3
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Reflective Mirror 
Round Frame

Advanced adjustment : Verticality of the optical path (selective adjustment)
Target: To adjust the laser spots obtained from the golden nozzle fastening ring and 
from the laser head outlet to the center of the circles.
Method:
1. Paste the tape : Take a piece of double-sided tape and paste it flat on the golden 

frame of the third reflective mirror.
2. Get the center laser spot : Move the laser head to the center manually > Close the 

door cover > Click “Laser Pulse” > Open the door cover.
3. Measure the center offset value : Measure the distance between the center of the 

spot and the center of the frame, x (mm). The laser spot should be located at the top 
of the perpendicular line of the metal frame (as shown in the picture above). If the 
position is incorrect, please contact your reseller.
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4. Move the third reflective mirror : Loosen the nut, use a double head wrench to 
loosen the nut holding the mirror adjustment screw > Adjust the 3 mirror adjust-
ment screws so that the third reflective mirror and the triangular mirror holder are 
parallel and have x (mm) spacing (as shown below).

5. Take the honeycomb table out : Move the laser head to the upper left of the 
working range > Reach the front of the machine, lift the honeycomb table up and 
pull it out.

6. Adjust the third reflective mirror : Refer to the method of "third reflective mirror" 
and adjust the laser spot to the center of the laser outlet again.

7. Paste the tape : Unscrew the golden nozzle fastening ring and remove the laser 
head > Take a piece of double-sided tape and paste it flat on the laser head socket, 
gently press the double-sided tape so that there is a socket indentation on the 
adhesive side of the double-sided tape.

8. Obtain the center laser spot : Move the laser head to the center manually > Close 
the door cover > Click “Laser Pulse” > Open the door cover > Observe the spot 
position and move the third reflective mirror as appropriate.

Working Area

CH 5-3
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To the rightCenterTo the left

9. Move the third reflective mirror (as shown below) :
a. The laser spot is in the center of the laser head socket, which means the optical 
path is vertical and does not need to be adjusted.
b. If the spot is to the right, reduce the parallel gap of the reflective mirror and 
loosen the 3 mirror adjustment screws by half a turn, then repeat steps 6-9 until the 
spot is in the center of the laser head socket.
c. If the spot is to the left, increase the parallel gap of the reflective mirror and 
tighten the 3 mirror adjustment screws by half a turn, then repeat steps 6-9 until 
the spot is at the center of the laser head socket.
After the adjustment is completed, please run "Calibrate Camera" first and then use 
the camera preview. 【Beam Studio Tutorial】Camera Calibration. (p.063)
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Door Cover 
Cleaning

It is recommended to clean 
every 2 weeks.

硬體準備內容：自行準備：1｜75％～99%酒精、2｜擦拭布

Maintenance Steps : Spray a small amount of alcohol on the acrylic door and clean 
with a cleaning cloth. The amount of alcohol should not be 
too much to avoid cracking the door.

1 2

161

Preparation Items : Self-preparation : 1｜75%~99% alcohol, 2｜Cleaning cloth

Working Area

CH 5-3
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Back Cover

The back cover includes the water 
pump, laser tube and ventilation fan.
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Laser Tube 
Replacement

Depending on the power, hours of 
usage, room temperature, water 
temperature and other conditions.

1. The degradation of the laser tube. 2. The failure of the laser 
tube which has no laser beam output as well as generates a 
cracking sound. Laser tube are classed as consumables, the deg-
radation is normal due to the use of power, storage time and oth-
er factors. The higher the power setting, the faster the laser tube 
degradation.

21

8 9 10

3 4
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Back Cover

CH 5-4

Self-preparation : 1｜Phillips screwdriver, 2｜Needle nose pliers, 
3｜Diagonal pliers, 4｜Water container, 5｜Paper towel or rag, 
6｜75%~99% alcohol, 7｜Vacuum cleaner or high-pressure spray 
gun *If you have one, it is better.
Included in the accessory box : 8｜Torx screwdriver, 9｜Double 
head wrench, 10｜Funnel, 12｜2.5mm hexagonal wrench
Included in the laser tube box : 11｜3mm hexagonal wrench, 
13｜Cable tie, 14｜Water pipe plug, 15｜Laser tube

Replacement 
Needed : 

Preparation 
Items :



164

1. Please unplug the power cord first, then replace the laser tube.
2. Please use the Torx screwdriver to remove the 6 screws on the back 

cover and then remove the back cover.
3. You can remove the dust from the back chassis first and then 

replace the laser tube. Use a vacuum cleaner or high-pressure spray 
gun to remove the dust from the back chassis, and then use a paper 
towel or rag with alcohol to wipe the dirty area and wait for the 
chassis to dry before proceeding with the next operation.

4. The laser tube has two ends. The high-voltage side is near the 
screen and the low-voltage side is near the reflective mirror.

High-voltage Side Low-voltage Side
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Replacement Steps :
1. Disconnect the laser tube wires : Unscrew and disconnect the white connector 

on the high-voltage side > Press the white terminal and pull out the ground wire 
on the low-voltage side.

2. Loosen the laser tube holders : Use a 3mm hexagonal wrench to loosen a total of 
4 screws on the laser tube holders.

165

Ground wireWhite terminal

Back Cover

CH 5-4
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3. Take the laser tube out to drain :

b. Use diagonal pliers to remove the cable tie holding the water hose > Move the 
laser tube out of the chassis >

a. Use needle nose pliers to move the hose clamp from the low-voltage side toward 
the center of the water hose >

166
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c. Aim the water hose on the low-voltage side at the water container, and then pull 
out the hose to drain the water (when the water outlet position of the low-voltage 
side is lower than that of the high-voltage side, the liquid will be discharged due 
to siphon principle) >

d. When the drainage is completed, clog the water outlet by a water pipe plug.

167

Back Cover

CH 5-4
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4. Remove the laser tube : 

b. Pull out the water hose on the high voltage-side and insert a water pipe plug >

a. To avoid water leakage, place a rag or paper towel under the high-voltage side > 
Use diagonal pliers to remove the cable tie fixing the water hose >

168
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c. Remove the laser tube completely.

5. Place the laser tube and water hose in :

a. Place the laser tube according to the picture >

169

Avoid contacting the machine parts with water. If water enters, dry 
the water, and wait for the air to dry before starting the machine.

Back Cover

CH 5-4
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b. Remove the water pipe plug on the high-voltage side and put the water hose on the 
glass tube > Remove the water pipe plug on the low-voltage side and put the water 
hose on the glass tube.

- There is no metal hose clamp at the high-voltage side to avoid 
leakage of electricity that may cause a drop in engraving power 
or a possible electric shock if the grounding is not confirmed.

- Slowly release the metal hose clamps to avoid breaking the tube.

170

Metal hose clamp

6. Fix the water hose on the laser tube : Fix the water hose at the high-voltage side 
on the glass tube with a cable tie > Tighten the cable tie and cut off the excess cable 
tie with a pair of diagonal pliers > Fix the water hose at the low-voltage side on the 
glass tube with a cable tie > Tighten the cable tie and cut off the excess cable tie 
with a pair of diagonal pliers > Put the metal hose clamp back.
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7. Connect the laser tube wire : Connect the white connector on the high-voltage 
side with a red wire back and tighten it > Press down the white terminal on the 
low-voltage side and insert the ground wire firmly > Release the white terminal and 
gently pull the ground wire to check if it is stable.

8. Tighten the laser tube holders back :

171

Red terminal on the 
high-voltage side

Back Cover

CH 5-4

a. Place the laser tube in position, leaving a finger distance between the head and 
tail ends > Rotate the red terminal on the high-voltage side towards the inside of 
the machine chassis > Make sure there is no folds or kinks of the water hoses

Ground wireWhite terminal
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9. Plug in the power cord and start the machine : After confirming the installation 
is correct, you can plug in the power cord and start the machine.

10. Activate the“Pump” : After the machine is turned on, click “MAINTAIN” on the 
screen > Click “Pump” after the laser head is homed. Then the cooling water will 
start to enter the laser tube and the water level of the water pump will drop.

11. Turn off the machine and unplug the power cord : When the water level of the 
water pump is 1/4 left, turn off the machine and unplug the power cord before 
adding the water manually.

- Please do not touch the area near the high-voltage side of the laser 
tube after plugging the power cord in to avoid electric shock.

- When using the “MAINTAIN” page, avoid touching the laser switch or 
putting your hand at the laser tube tail end. If the water pump cannot 
be activated, please contact your reseller.

- Please observe the water level carefully to avoid overflowing.
- Please use distilled water to avoid impurities affecting the water  

-cooling effect.

b. Use a 3mm hexagonal wrench to tighten a total of 4 screws on the laser tube 
holders > Gently shake the laser tube to make sure it will not shift left and right 
and forwards and backwards.
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12. Add water manually : Use the double head wrench to open the water pump cap > 
Put in the funnel > Fill the water pump with distilled water.

13. Tighten the water pump cap back :  Repeat steps 9 ~ 12 until the water pump 
level reaches 80% full and the water level no longer drops due to the adding into 
the laser tube, then use the double head wrench to tighten the water pump cap 
back to complete the laser tube replacement procedure.

- It is recommended to fill the water to more than 80% full or press 
the water hose when adding water, so it is less likely to produce air 
bubbles.

- There should not be a large number of air bubbles inside the laser 
tube to avoid affecting the heat-dissipation efficiency.

Water pump cap

Back Cover

CH 5-4
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Water changing 
and adding

Once every 3 months

Notes : In order to avoid the breakage of the glass laser tube due to the heat gen
erated during laser excitation, it is necessary to maintain the water-cooling 
effect with sufficient distilled water.

1

4 5

2

6
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Preparation Items : Self-preparation : 1｜Needle nose pliers, 2｜Water container, 
3｜Paper towel or rag
Included in the accessory box : 4｜Torx screwdriver, 5｜Double 
head wrench, 6｜Funnel
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1. Please use the Torx screwdriver to remove the 6 screws on the back 
cover and then remove the back cover.

2. Too many air bubbles in the laser tube will affect the cooling 
efficiency, it is recommended to circulate the water and fill the wa-
ter pump to more than 80% full or press the water hose when add-
ing the water, so it is less likely to produce air bubbles.

3. It is recommended to replace the cooling water once every three 
months.

4. The mesh part of the honeycomb table is sharp, so please be care-
ful with it.

5. As shown below. If the machine is the autofocus version, you need 
to press the side button to retract the laser head, and to avoid hit-
ting the probe when taking out the honeycomb table. 

6. If the laser head cannot be moved, please click “MAINTAIN” on the 
screen > “Motors” to release the motors.

Maintenance Steps:

1. Take the honeycomb table out : Move the laser head to the upper left of the 
working range > Reach the front of the machine, lift the honeycomb table up and 
pull it out.

175
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2. Take the laser head out :
Manual focusing : Unscrew the nozzle fastening ring > Take the laser head down

ward and forward out.
Autofocus : Press and hold the side button, move the laser head down to the 

bottom and release the button > Use 2.5mm hexagonal wrench to 
loosen the set screw on the left side of the laser head > Move the laser 
head down and out.

3. Unscrew the barb fitting and aim the laser head at it :

a. Unscrew the barb fitting near the low-voltage side (near the reflective mirror) on 
the flow sensor >

176

Set screw

Barb fitting

Flow sensor

Nozzle 
fastening ring

Side button

Manual Focusing Autofocus



177

b. Place the flow sensor inside the water container > Lift up the water hose near the 
low-voltage side slightly to let some water flow out >

c. Aim the laser head outlet at the barb fitting opening. Be sure to ask someone to 
assist in holding the flow sensor above the water container to avoid spilling water 
after the air pump is activated

177

Barb fitting opening

Laser head

Back Cover
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4.  “Air Pump” helps to drain the water : Click the “MAINTAIN” on the screen > 
Click “Air Pump” to activate the air flow, the cooling water will be drained from the 
water hose near the high-voltage side > After emptying the water, click “Air Pump” 
to stop the air flow.

5. Dry and install the laser head : Use paper towels or a rag to dry the laser head >
Manual Focusing : Put the laser head backward and upward > Tighten the nozzle 

 fastening ring.
Autofocus : Insert the laser head under the Autofocus add-on and push the 

black air hose to the top > Use 2.5mm hexagonal wrench to tighten the 
set screw on the left side of the laser head.

178

Hose clamp

Flow sensor

178

6. Connect the barb fitting back : Pre-turn the water hose by two turns to two and a 
half turns (the position of the hose clamp can be used as a reference) > Connect the 
barb fitting back to the flow sensor.

Set screw
Nozzle 
fastening ring

Side button

Manual Focusing Autofocus
Autofocus 
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7. Turn off the machine and unplug the power cord : Turn off the machine and 
unplug the power cord before adding the water manually.

8. Add water manually : Use a double head wrench to open the water pump cap > 
Put in the funnel > Fill the water pump with distilled water.

9. Plug in the power cord and start the machine : Plug in the power cord and start 
the machine.

10. Activate the“Pump” : After the machine is turned on, click “MAINTAIN” on the 
screen > After the laser head is homed, click “Pump”, then the cooling water 
starts to enter the laser tube, and the water level of the water pump drops. If the 
water pump does not work, please contact your reseller.

11. Tighten the water pump cap back : Repeat steps 7 ~ 10 until the water pump 
level reaches 80% full and the water level no longer drops due to the adding into 
the laser tube, then you can use a double head wrench to tighten the water pump 
cap back to complete the water change.

- Please observe the rising water level carefully to avoid overflowing of water.
- Please use distilled water to avoid impurities affecting the water-cooling effect.
- Please do not touch the area near the high-voltage side of the laser tube after 

plugging the power cord in to avoid electric shock.
- When using the ”MAINTAIN” page, avoid touching the laser switch or putting your 

hand on the tail end of the laser tube.
- It is recommended to fill up the water to more than 80% full or press the water 

hose when adding the water, so it is less likely to produce air bubbles.
- There should not be a large number of air bubbles inside the laser tube to avoid 

affecting the heat-dissipation efficiency.
- Check that the water hose should not be folded or kinked to avoid affecting the 

smoothness of water flow.

Back Cover

CH 5-4

Water pump cap
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Ventilation 
Fan Cleaning

It is recommended to clean 
once every 1 month.

Preparation Items : Self-preparation : 1｜Brush, 2｜75%~99% alcohol.

Maintenance Steps : Remove the dust from the ventilation fan with a brush, then 
wipe the ventilation fan blades with alcohol.

1 2
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Trouble-
shooting

This manual classifies the issues into three cat-
egories according to their contents, including 
hardware, software, and comprehensive issues. 
The test items and solutions for each problem 
are explained here in order.

FLUX > “Supports” > “Help Center” has more resources to help users 
with easy troubleshooting. If you cannot follow the guides from this 
manual or Help Center, you need to collect relevant information (trou-
bleshooting records) and contact your reseller. *Please refer to 6-5 for 
the troubleshooting records and contact your reseller with all the items 
in order to solve the problem faster.
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Issue Category

#900

#901

#902

#903

#904

Issue Content (Error Code) Test Items

Cooler Off Water hose, water pump, 
flow sensor

Door Opened Door cover sensor magnet, 
magnetic reed switch

Overheated

Bottom Cover 
Opened

Homing Failed

Focus probe of manual 
focusing is cracked

Room temperature, water 
temperature, water pump

Material cannot be cut 
through

Focusing, power on the screen, 
reflective mirrors and focus 
lens, optical path, laser tube

No Laser Beam Output Laser tube

Bottom cover fixing screw, 
bottom cover magnet, mag-
netic reed switchm rotary 
add-on magnet

Mirrors and lens are 
oxidized or broken

Reflective mirrors and focus 
lens

Click “MAINTAIN” on the 
screen to home

Minor electric shocks 
from chassis -

-

Connection Issue MAC Address, IP address, 
“Test Network Settings”

Unable to Open 
Software Properly

Windows :Visual C++ 
Redistributable / 
macOS : Version

Camera preview screen 
stitching is inaccurate, 
Actual engraving position 
is different from camera 
preview position

Focus plane, camera calibra-
tion, SVG file

Other Software Error Codes -

Camera preview speed is 
too slow

Camera preview screen is 
overexposed

Camera Preview Timeout 
or Failed to Connect

Camera preview screen 
is blurry

“Camera” in the MAINTAIN 
page 

Camera lens

Wi-Fi dongle, network envi-
ronment

Ambient lighting

Hardware

Software

Comprehensive

Troubleshooting

CH 6-1
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Hardware 
Issues
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Cooler Off
#900

- Make sure that the firmware is version 
3.4.0 or later.

- Remove the back cover after removing a 
total of 6 screws with a Torx screwdriver.

1 2

4

6

3

5 7
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Preparation Items : Self-preparation : 1｜Distilled water, 2｜Water container, 
3｜Cable tie, 4｜Diagonal pliers
Included in the accessory box: 5｜Torx screwdriver, 6｜Double 
head wrench, 7｜Funnel
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Test Items:

1. Click “Resume” button : Try to continue working, if no error message appears 
again within one minute, then it can be used normally.

2. No folds or kinks of the water hose : If the water hose is obviously creased, 
press the area back to the cylinder shape > Use the cable tie to fix the position.

3. The water pump should be at least 80% full : If the water level in the water 
pump does not reach 80% full, water must be added【Maintenance】 Water 
changing and adding. (p.174) > Press the water hose to discharge the air bubbles 
inside the laser tube as many as possible.

4. Adjust and test the flow sensor : Tilt the sensor slightly and tap it a few times to 
expel the air bubbles > Test the flow speed, which should be 1 ~ 2 L/min: Machine 
screen > “MACHINE” > “Hardware Settings” > “Test Flow Speed”.

5. Replace the cooling water : If you have tried steps 1 ~ 4 and still have an error, 
please replace the cooling water【Maintenance】Water changing and adding. 
(p.174). It would be helpful if you can record a video at the same time.

Troubleshooting Records:

1. Photo : Machine screen > “MAINTAIN” > Turn on the “Pump” and take pictures of :
a. Water hose (bending at the connection)
b. Laser tube (the number of bubbles and flowability)
c. Water pump (water volume, water pump blue light should be constantly on)
d. Flow sensor (placement, reading), as the right figure.

2. Video : The video of cooling water replacement
should include the content of photos (water hose, 
laser tube, water pump, flow sensor) to ensure 
that the above components are working properly.

Flow sensor

Water pump

Air bubble inside the laser tube
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Door Opened
#901 Make sure that the firmware 

is version 3.4.0 or later.

Preparation Items : Self-preparation : 1｜Super glue, 2｜Magnet 
                                 Included in the accessory box : 3｜Torx screwdriver

1 2 3
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Test Items:

1. Check the door cover sensor magnet : If the door cover sensor magnet is off but 
not lost, you can point super glue at the magnet base to glue the magnet back. If 
the magnet is lost, please contact your reseller.

2. Test the magnetic switch :
a. Use a Torx screwdriver to remove 6 screws on the back cover, remove the back 
cover > Click “MAINTAIN”  on the screen > Open and close the door cover contin-
uously, observe whether the door cover symbol is displayed normally in the upper 
right corner.
b. Take another magnet to cover the magnetic switch > Close the door cover > 
Observe if the door cover symbol is displayed closed normally in the upper right 
corner, as shown in the figure.

Troubleshooting Records :

1. Photo :
a. Magnet (whether it is off)	
b. Door cover sensor magnet and magnetic 
reed switch area after closing the door cover

2. Video :
a. Need to include the action of opening and 
closing the door cover and the change of the 
door cover symbol.
b. Record the change of door cover symbol 
before and after taking a magnet to cover 
the magnetic reed switch.

Door cover 
opened

Door cover 
closed

Magnetic reed switch

Door cover 
sensor magnet
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Overheated
#902

Preparation Items : Self-preparation : 1｜Distilled water
Included in the accessory box: 2｜Funnel, 3｜Double head 
wrench, 4｜Torx screwdriver

1 2
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Overheated warning temperature can be adjust-

ed in "MACHINE" > "Hardware Settings" > "Wa-

ter Temperature Threshold".

High water temperature will degrade the laser 

tube faster, so it is recommended to prevent the 

overheated warning by decreasing the room 

temperature instead of increasing the water 

temperature threshold.

Hardware Issues
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Test Items:

1. Room temperature should not be too high :
a. Keep the right side of the machine heat vent open and should not shade the 
bottom air intake.
b. Room temperature above 30°C is not suitable for the use of CO2 laser.

2. Water temperature should not be too high : The water temperature should be 
between 5°C-30°C.
a. The starting temperature of water is low, or the machine has good heat dissipa-
tion ability, the continuous cutting time can be longer.

3. Reduce the high-power operation time :
a. If the water temperature is too high due to continuous cutting, you should wait 
for the machine to dissipate heat and the water temperature to decrease before 
clicking “Resume” for operation. This will not affect the engraving result. A suit-
able pause in cutting will help to improve the heat dissipation and can effectively 
increase the continuous cutting time.
b. Arrange engraving works between the cutting jobs so that the laser tube can 
have enough time to dissipate heat.

4. The water pump should be at least 80% full : More water will make the water 
temperature rise more slowly. If the water level in the water pump is less than 80% 
full, water should be added【Maintenance】 Water changing and adding. (p.174) 
> Press the water hose to discharge the air bubbles inside the laser tube as many 
as possible. The water-cooling system of this model is a closed water circuit, if the 
water pump cap is covered, general use will not cause water evaporation, the wa-
ter level of the water pump drops, if the water level decreases significantly within 
a week, please contact your reseller. 
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5. Water cooling fans work normally : Put the right half of the machine out of the 
table for testing > Press the “MAINTAIN” on the machine screen > Click “Pump”. 
After the water pump is turned on, you can reach underneath the machine and 
feel whether the two water cooling fans have normal air inlet (the air outlet is 
located on the right side of the machine and the air volume is too small to judge).

Troubleshooting Records :

1. Photo : Flow speed reading 
(should be greater than 1.0 L/min) 
(“MACHINE” > “Hardware Set-
tings” > “Test Flow Speed”)

Hardware Issues
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Bottom Cover Opened
#903

Preparation Items : Self-preparation : 1｜Super glue, 2｜Magnet

1 2

194
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Test Items :

1. Check the bottom cover fixing screw : Remove the honeycomb table【Mainte
nance】Honeycomb Table Cleaning, step 1. (p.137) > Confirm whether the 4 fixing 
screws on the bottom cover are tight. 

2. Check the bottom cover magnet : Unscrew the 4 screws on the bottom cover 
counterclockwise > Remove the bottom cover and make sure the magnet on the 
left side of the bottom cover is not disconnected or missing. If the magnet on the 
bottom cover is off but not lost, you can glue the magnet back on the magnet base 
with super glue. If the magnet is lost, please contact your reseller.

3. Test the magnetic reed switch : Unscrew the 4 screws on the bottom cover 
counterclockwise > Click “MAINTAIN” on the screen > Take another magnet to 
cover the magnetic reed switch > Close the bottom door cover > Observe the door 
cover symbol in the upper right corner to see if it is closed normally.

Door cover 
opened

Door cover 
closed

Bottom cover 
magnet

Bottom cover 
fixing screw
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switch 
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4. Check the rotary add-on magnet : If you are using a rotary add-on, please make 
sure the magnet on the rotary add-on is not missing. If the magnet is missing or 
damaged, please contact your reseller.

Troubleshooting Records:

1. Photo : Take pictures of
a. Bottom cover magnet (whether it is off)
b. Rotary add-on magnet (whether it is off)

2. Video : Test the magnetic reed switch, including the use of external magnet, and 
the change of the door cover symbol before and after tightening the bottom 
cover back.

Rotary add-on magnet
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Homing 
Failed

#904

Troubleshooting Records :

1. Video : The complete homing process should be recorded.
The screen should cover the whole machine. When the homing process starts, focus 
on recording the screen and sound at the top left of the machine. Manually pull the 
laser head to the center of the working range > click “MAINTAIN” on the screen, 
then the laser head will move up to the top and then move left to the far left to 
complete the homing. As shown in the picture.

Since the reason for "#904 Homing 
Error" is rather complicated, please 
provide the troubleshooting video 
to your reseller directly.

Hardware Issues
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Preparation Items : 1｜Acrylic with thickness from 3mm to 5mm, 2｜Needle nose pliers
                                Support Center : 3｜Focus probe cutting file (.dxf)

1 2

Focus probe of manual focusing is cracked

198
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Operation Steps :

1. Download the focus probe cutting file : Go to the official website > “Supports” > 
“Help Center” and search for the focus probe cutting file > download the file.

2. Cut the focus probe : Put in the acrylic > Focus, so that the distance from the laser 
outlet to the acrylic is 12mm (about the thickness of 6 NT$10 coins) > Import the fo-
cus probe file into Beam Studio > Adjust the cutting parameters > Send out the work.

3. Remove the air hose from the laser head :
a. Take out the honeycomb table as shown above. 【Maintenance】 Honeycomb 
Table Cleaning, step 1 (p.137) >

b. Unscrew the nozzle fastening ring > Remove the laser head > Take out the laser 
head and the black air hose forward and downward.

Nozzle fastening ring

Laser head

Black Air Hose

199
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c. Move the old focus probe back and away from the laser head.

d. Hold the black air hose at the back end of the pliers with a low density saw 
tooth and rotate the laser head counterclockwise to remove the air hose. Avoid 
deformation of the hose during the removal with the pliers.

200
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4. Replace the old focus probe with a new one : Remove the old focus probe > 
Put the new focus probe into the black air hose.

5. Put back the air hose on the laser head :
a. Rotate the laser head clockwise to combine the black air hose with the laser 
head.
b. Place the laser head and black air hose upward and backward so that the hose 
is placed in the slot.
c. Tighten the nozzle fastening ring > Move the focus probe toward the laser head 
so that it is flat against the outside of the bracket > Place the honeycomb table 
back【Maintenance】Honeycomb Table Cleaning, step 3 (p.137).

6. Check the air pump : Click “Air Pump” on the screen > Place a piece of paper at 
the laser outlet and test whether the laser head is blowing air normally. If there is 
no air, please contact your reseller.

Troubleshooting Records : 

1. Video : Place a piece of paper at the laser outlet and record the laser head blow
ing air. (Click “MAINTAIN” on the screen > “Air Pump”)

Focus probe attached 
flat to the outside of 
the mount metal
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Material cannot 
be cut through

elf-Preparation Items: As 
described in the Test Items.

Test Items :

1. Make sure the focus is correct :
Manual focusing : When the focus probe is turned down, it should just touch the 

surface of the engraving material.
Autofocus : Double click the side button, the probe should just touch the surface 

of the engraving material and the distance between the laser head 
and the surface of the engraving material should be 12mm±1mm.

2. Check the screen power setting : The power on screen is preset to x1.00. If the 
software power and the screen power are multiplied by less than 17%, it is possible 
that there is no laser beam output.

3. Make sure the mirrors and lens are clean and undamaged : Clean the reflective 
mirrors and focus lens, please refer to【Maintenance】Mirrors and Lens Cleaning 
(p.140).

4. Make sure the optical path is not misaligned :
a. Put the double-sided tape on the first reflective mirror > Make sure the laser 
spot is on the first reflective mirror.
b. Apply the double-sided tape to the second reflective mirror > Make sure the 
bottom left and top left laser spots overlap.
c. Apply the double-sided tape to the third reflective mirror > Make sure the mid-
dle right and middle left laser spots coincide.
d. Apply the double-sided tape to the laser outlet > make sure the laser spot is 
in the center.
If the above conditions cannot be met, it means the optical path is misaligned and 
needs to be aligned 【Maintenance】Optical Path Alignment (p.148).

5. Confirm that the laser tube is not degrading : If you have confirmed 1~4 items 
but still cannot cut the engraving material, please contact your reseller.

First reflective mirror

Second
reflective
mirror

Third reflective mirror

Focus
lens

Top right

Middle rightMiddle left Center

Bottom rightBottom left

Top left

X-axis

Y-axis

Z-axis
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Troubleshooting Records :

1. Photo : Take pictures of
a. 3 reflective mirrors (whether there are stains)
b. Focus lens (whether there are stains)

c. Double-sided tapes on 3 reflective mirrors after optical path alignment (shapes 
and colors of laser spots)

Focus lensReflective mirror
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No Laser Beam Output

1 2 43

204

Preparation Items : Self-preparation : 1｜2.5mm hexagonal wrench
Included in the accessory box : 2｜Torx screwdriver, 3｜Double 
head wrench, 4｜Double-sided tape
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Test Items :

1. Stop using the machine when there is an abnormal sound : If the laser outlet 
does not show light and the laser tube makes a "cracking" sound during the use 
of the machine, it means that the laser tube is malfunctioning, please stop using it 
immediately to avoid overloading the power supply and causing damage to other 
parts.

2. Observe whether there is light in the laser tube : If there is no obvious noise but 
still no laser beam comes out, please observe whether there is a light from the 
laser tube. Go to the “MAINTAIN” page > Make sure the power setting is x 1.00 > 
Close the door cover > Click on “Laser Pulse” > At the moment of clicking, you 
should see a pinkish fluorescent light instantly from the laser tube observation 
hole. If there is fluorescence, it means the laser is operating normally, please refer 
to 【Maintenance】Optical Path Alignment (p.148). If there is no fluorescence, 
please contact your reseller.

Troubleshooting Records :

1. Video : Record the laser tube observation hole status at the moment of pressing 
“Laser Pulse” (whether there is pinkish fluorescence).

2. Photo : If there is pink fluorescence, please provide double-sided tapes on 3 
reflective mirrors after optical path alignment (shapes and colors of laser spots).

Laser tube shows a pinkish 
fluorescent light
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Mirrors and lens are oxidized or broken

Preparation Items : Self-Preparation : 1｜Needle nose pliers
Included in the accessory box : 2｜Torx screwdriver

1 2
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Test Items :

1. Check if mirrors and lens are oxidized or broken : If there are black spots, white 
spots, etc. on the surface of the first and second reflective mirror, or if there are se-
rious scratches, and the stains cannot be removed by【Maintenance】Mirrors and 
Lens Cleaning (p.140), or if the focus lens is deformed or broken due to external 
force, the mirrors and lens should be replaced.

Matte side

Shiny side

Oxidized reflective 
mirrors

Aluminum cover

Replacement Steps :

First reflective mirror :
a. Open the back cover: Please use a Torx screwdriver to remove the 6 screws on the 
back cover and then remove the back cover.【Maintenance】Optical Path Alignment 
(p.148) >
b. Loosen the aluminum cover: Loosen the aluminum cover that fixes the mirror (face 
the mirror and turn counterclockwise), if it cannot be turned, use needle nose pliers to 
clamp the aluminum frame and turn again >
c. Replace the mirror: Take out the old mirror > Put the new mirror with the matte side 
facing the mirror holder (laser beam will hit the shiny side) > 
d. Tighten the aluminum cover: Tighten the aluminum cover back to the mirror holder.

207
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Second reflective mirror : After opening the door cover, follow the first reflective 
mirror steps b~d (the position of the second reflective mirror is indicated in the 
picture in p.201).
Third reflective mirror :
a. Move the bracket downward: As shown in the picture above, unscrew the nozzle 
fastening ring > Push the bracket down to the end so the subsequent steps will be 
easier to operate > 
b. Loosen the fixing cap: Use the needle nose pliers to hold the two round points of 
the fixing cap of the mirror, and unscrew the fixing cap counterclockwise > 
c. Replace the mirror: Take out the old mirror, you can pull out the mirror from the 
laser inlet area > Place the new mirror with the shiny side facing the mirror holder > 
d. Tighten the fixed cap: Use needle nose pliers to hold the two round points of the 
fixing cap of the mirror, and tighten the fixing cap clockwise.

Nozzle
fastening ring

Bracket

Fixing cap

208
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Focus lens:
a. Remove the honeycomb table【Maintenance】Honeycomb Table Cleaning, step 1 
(p.137).

b. Loosen the fixing cap : Unscrew the nozzle fastening ring > Remove the laser head 
> Turn the silver mounting cap counterclockwise from the laser head, if it cannot be 
unscrewed, use needle nose pliers to assist >

Silver mounting

Nozzle
fastening ring

209
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c. Replace the lens: Remove the old lens > Put the new lens into the laser head with 
the flat side downward (hold the edge of the lens and look into the lens, you can see 
yourself on the convex side, but you cannot see yourself on the flat side) >
d. Tighten the fixing cap: Tighten the silver mounting cap clockwise > Put the laser 
head back into the laser head socket > Tighten the nozzle fastening ring.
e. Put the honeycomb table back 【Maintenance】 Honeycomb Table Cleaning, step 
3 (p.137).

Troubleshooting Records :

1. Photo : Take pictures of
a. 3 reflective mirrors (whether oxidized or broken)
b. Focus lens (whether oxidized or broken)

Flat sideConvex side

Focus lensReflective mirror	

210
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Minor electric shocks from chassis

Preparation Items : Self-preparation : 1｜Phillips screwdriver, 2｜Ground wire, 
3｜3-prong adapter

Everyone's sensitivity to electric current is different, that is, everyone will have dif-
ferent degrees of feelings about leakage. Due to the design mechanism of the laser 
tube, there will be a slight controlled leakage current for the tube to function proper-
ly, which is a normal phenomenon, do not worry too much. The laser cutting machine 
must be properly grounded while using. If it is properly grounded, there will be no 
leakage. If you touch the machine when it is operating, and you may feel a minor elec-
tric shock, it maybe the 3-prong outlet is not properly grounded, or the third prong 
is not fully grounded.

Solution :
1. DIY grounding : Connect the 
machine's power cord to a 3-prong 
adapter > Connect the adapter's 
ground terminal to the building's 
metal piping to achieve an approxi-
mate grounding effect.
2. Wear shoes to use the machine : 
Avoid using the machine with bare 
feet, wearing shoes can reduce the 
risk of electric shock.
3. Plug the adapter into the outlet 
reversely : If you are unable to DIY, 
connect the power cord to the 
3-prong adapter and plug it into 
the outlet in the opposite direction 
(rotate 180 degrees).

1 32
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Windows
If your computer pops up a not responding window when you open the software, 
please make sure you have installed Visual C++ Redistributable on your computer.
Please install Visual C++ redistributable packages for Visual Studio 2015, 2017 and 
2019.
macOS
Please update your system to macOS 10.14 (Mojave) or above. Some older versions 
of macOS may have support issues.

Steps to Follow :

1. Record :
a. Record the current software and firmware versions.
b. Explain the operation behavior (or recording) and take screenshots.

2. Export a bug report : Export a bug report when an error message pops up. 
(Menu > “Help” > “Bug Report”)

3. Retry: Reopen the software > Retry the behavior.
4. Check the Help Center : Go to official website “Supports” > “Help Center” to 

search for solutions. (https://support.flux3dp.com/hc/en-us)
5. Update software and firmware : Update software and firmware to the latest beta 

version > Retry the behavior.
6. Record again : As in step 1.
7. Export another bug report : As in step 2.

Troubleshooting Records : 

1. The information collected in steps 1, 2, 6, and 7.
2. .beam files and image files, etc.

When the software is abnormal, error messages will pop up in your computer 
window. If you are unable to follow the steps below to resolve the software issues, 
please contact your reseller.

Unable to Open Software Properly

Other Software Error Codes

Software Issues
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Connection 
Issue

Make sure that the MAC Address in the 
"NETWORK" of the machine screen has a 
value, IP address starts with 192.168 and 
the network quality is good so that you 
can have a stable connection.

Preparation Items : Self-preparation : 1｜Ethernet cable (Wired Network*1 or 2, 
Direct Connection*1) 
Included in the accessory box: 1｜Ethernet cable, 2｜Wi-Fi 
dongle

1 2 3
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Test Items :
1. There is a value for MAC Address in the "NETWORK" page :

a. Wi-Fi :
Screw the Wi-Fi dongle firmly > Fold the dongle antenna up 90 de-
grees and insert it into any USB socket on the back of the machine 
> Click "NETWORK" on the machine screen > Check whether MAC 
Address under Wireless Network has a value, as shown below. If there 
is a value, then please go directly to the 2nd test item. If there is no 
value, please insert the Wi-Fi dongle into another USB socket for use. 
If neither socket shows the MAC address, please contact your reseller.

b. Wired Network : (machine - router – computer, take 2 ethernet 
cables as an example):
One RJ45 ethernet cable connects the machine to the router and the 
other RJ45 ethernet cable connects the router to the computer > 
Click "NETWORK" on the machine screen > Verify that MAC Address 
under Wired Network has a value, as shown below. If there is a value, 
please go directly to the 3rd test item. If there is no value, please try 
to replace the network cable or contact your reseller.

c. Direct Connection (machine-computer) :
A RJ45 ethernet cable is connected to the machine and the computer 
on both ends > Enable Internet connection sharing【Start】2-5.3 Di-
rect Connection (p.055), Windows setting as 1, c, MacOS setting as 
2, c~e > Click "NETWORK" on the machine screen > Check if the MAC 
Address under Wired Network has a value, as shown below. If there is a 
value, then you can go directly to the 3rd test item. If there is no value, 
please try to change the network cable or contact your reseller.
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2. "Connect to WiFi": ”Connect to WiFi" > Select the Wi-Fi you want to use > Enter 
the Wi-Fi password and press “Confirm”.

3. Confirm the beginning of IP address :

4. Fill the IP address of machine in Beam Studio: Fill the IP address starting with 
192.168 in the software.

5. Test the connection stability : If the software still cannot find the machine after 
filling the IP into the software, please confirm the connection stability.
a. Menu > "Machines" > "Test Network Settings" > 

a. Windows :
Menu > “File” > “Preferences” > Machine IP Address > Apply.
b. macOS :
“Beam Studio" > "Preferences" > Machine IP Address > Apply.
c. Linux :
“Beam Studio” > “Preferences” > Machine IP Address > Apply.

a. If the Wi-Fi name is not displayed :
Make sure the Wi-Fi channel is 2.4Ghz, the machine does not support 5Ghz.
b. If Wi-Fi name is displayed, but you cannot connect to it :
Check the Wi-Fi encryption type, it should be WPA2 or None (no password). The 
encryption type can be set by your computer, but be aware that not all routers 
support WPA2.
c. Unable to connect to iPhone hotspot :
Make sure the phone hotspot name should not have special characters or non-
English characters. If the phone system is iOS 13, keep the hotspot page open 
when the machine connects to the hotspot; if the connection fails, turn off the 
hotspot for about 10 seconds, then reopen the hotspot and try to connect again.

a. Wi-Fi :
Make sure the "Wireless IP" of the machine starts with 192.168.
b. Wired Network :
Verify that the "Ethernet IP" of the machine starts with 192.168.
c. Direct Connection :
Verify that the "Ethernet IP" of the machine starts with 192.168.
d. If the IP address starts with 169.254 :
If the IP address starts with 169.254, it means that the network interface card did not 
obtain the IP address automatically. And usually this is because the router does not 
have DHCP service enabled or the DHCP service is malfunctioning. Please contact 
your internet service provider to turn the DHCP function on.
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b. Fill in the IP of the machine you want to use in "Target device IP address" > 
"Start" >
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c. The test data includes Connection Quality and Average Response Time >

After Beam Studio version 1.4.2, Connection Quality > 70 and Average Response 
Time < 100ms means the connection is stable. If the connection is stable but the 
software cannot find the machine, please update the software and fill in the IP in 
“Preferences” > Machine IP Address. If the connection is not stable, please check 
the Wi-Fi signal strength and whether the computer and the machine are using the 
same network.

If you have other connection problems, please refer 
to “FLUX > Supports > Help Center > Beam Studio > 
Connection” for other instructions.
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Dongle antenna

Ethernet port

Antenna
connector

Troubleshooting Records :

1. Photo : Connect the Wi-Fi dongle or ethernet cable > Turn on the machine > Click 
"NETWORK" and take pictures of :
a. Antenna (connector, angle) or etherne port
b. Wireless Network MAC Address, Wired Network MAC Address
c. Wireless IP, Ethernet IP
d. Screenshot of the result of “Test Network Settings”
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Accurate focus and calibration can make the preview picture stitching more accu-
rate and make the engraving position consistent with the preview position.

Test Items :

1. Confirm the correct plane of focus :
Manual Focusing : When the focus probe is turned down, it must touch the 

surface of the engraving material, and every time you change 
the material of different thickness, you need to adjust the height 
of the laser head to ensure the correct focus.

Autofocus : Double click the side button on the side of the autofocus add-on 
above the engraving material to allow the laser head to automatically 
reach the correct plane of focus. When engraving, if the focus is not 
correct, the laser beam will be thicker than the laser beam with correct 
focus.

Camera preview screen stitching is inaccurate, 
Actual engraing position is different from camera 
preview position
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Focus probe

Nozzle 
fastening ring

Side button

Manual focusing mechanism Auto focusing mechanism
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Troubleshooting Records :

1. Image file : If there is still a discrepancy between the result and the preview 
position after using SVG file and confirming the correct plane of focus and accu-
rate camera calibration, please provide the SVG file to the your reseller and let the 
engineering team assist.

25mm

25mm

(X,Y) = (77.5mm, 77.5mm)

Focus probe

Thicker object : When the object is thicker or when the rotary add-on is used, the 
side of the object may be captured by the camera, and only the objects on the plane 
of focus can be stitched together, and the picture out of focus and inaccurate stitch-
ing caused by the height difference is normal. Be sure to focus on the surface of the 
engraving material and the highest point of the engraving material when using the 
rotary add-on.
2. Complete camera calibration (left picture) :

After exposing to shock and vibration of transportation, optical path alignment, 
and Reset to Factory, etc., all need to be recalibrated. The calibration steps are as 
described in【Beam Studio Tutorial】Step 2 (p.063).
There are two calibration objectives:
a. The red square must be located in the center of the calibration window.
b. The outside of the red square must be aligned with the center square of the
grid lines

3. Confirm the calibration result (right picture ): Draw a square at (X,Y) = (77.5mm, 
77.5mm) with a width W and height H of 25mm and make sure the square overlaps 
with the center square of the grid lines. If it does not fit, refocus the paper and 
recalibrate the camera.
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Troubleshooting Records : The reason 
for not being able to use the camera may 
be related to hardware or software, so 
please directly provide the troubleshoot-
ing video to your reseller for evaluation.

1. Video : The screen should cover the 
whole machine, focusing on recording 
the machine screen. Click "MAINTAIN" 
> "Motors" > "Camera" > Open the door 
cover > Slowly move the laser head 
around the working range for 3 rounds 
and observe whether there is a picture 
on the screen, as shown in the picture, 
if the picture is white, please contact 
your reseller. (Note that the camera up-
dates the screen every 3 seconds.)

Camera Preview Timeout or Failed to Connect

Test Items :

1. Wi-Fi dongle is not loose : Make sure the Wi-Fi dongle at the back of the 
machine is not loose, and the antenna connector has been tightened.

2. Shorten the distance between the machine and the hotspot : Shorten the 
distance between the machine and the wireless network source (router or hotspot), 
or try to use wired connection. If the above items do not solve the problem of slow 
camera preview speed, please refer to "Camera Preview Timeout or Failed to Con-
nect" or contact your reseller.

Camera preview speed is too slow
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Camera preview screen is blurry

Preparation Items : Self-preparation : 1｜Cotton swab, 2｜75%~99% alcohol

1 2

Test Items :

1. Check the cleanliness of the camera lens : Click "MAINTAIN" on the screen > 
"Camera" > check the cleanliness of the lens from the screen panel.

224
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Operation Steps :

1. Clean the camera lens : Use a cotton swab with a small amount of alcohol to 
clean the camera lens > Then use a dry cotton swab to dry the lens.

2. Confirm the camera screen :
a. Click "MAINTAIN" > "Camera" > confirm the lens is clean from the screen panel.
b. Use the software Beam Studio camera preview function to confirm that the 
camera preview screen is clean.

Camera preview screen is overexposed

Preparation Items : Self-preparation : 1. dark fabric or cardboard.

Test Items :

1. Confirm that the environment is free of strong light interference :
a. Check that there is no strong light above the machine, such as track lights, 
flurescent lamps, etc. 
b. Make sure the machine is not placed in a place in harsh sunlight.

Operation Steps :

1. Remove or shield the strong light source :
a. Cover the acrylic door cover above the engraving material with a dark fabric or 
cardboard.
b. Turn off the indoor light source above the machine.

2. Retry the camera preview : Make sure that the camera preview screen is back to 
normal.

Camera lens
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Service

The contents of this chapter are subject 
to actual use.
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Contact Customer Service

CH 6-5

FLUX > “Supports” > “Help Center” has more resources to help users 
with easy troubleshooting. If you are unable to troubleshoot a problem 
according to this manual or Help Center, please provide the following 
items to your reseller.

The following information is subject to actual use :

Contact your reseller to get a prompt support!
Contact  FLUX :
Private message to Facebook fan page : https://www.facebook.com/flux3dp.tw
email : support@flux3dp.com
 

Name :
Telephone :
email :
Address :
Purchasing platform : For non-FLUX official website purchasers, please provide a 

photo of the order details.
Operating system : Windows / macOS / Linux
Software version : Windows: Menu > “Help” > “About Beam Studio”.

macOS: Menu > “Beam Studio” > "About Beam Studio”.
Firmware version : Machine screen, “MACHINE” > Firmware Version.
Laser tube usage hours : Machine screen, “MACHINE” > Laser Tube Usage.
Machine serial number : Please provide a photo of the sticker on the back of the 

machine.
Troubleshooting Records : Please provide photos or videos according to the Trou- 

bleshooting Records in this chapter.

Help center
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Warranty

The contents of this chapter are subject 
to actual use.
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Warranty

CH 7

During the production process, FLUX Technology Inc. (hereinafter as, “we, us, our, 
FLUX”) examines FLUX products strictly to ensure the quality and reliability of the 
products before delivery to the customer. Nevertheless, under certain circumstances, 
products may not perform as expected. If any problem occurs, please first make sure 
you have followed the setup instructions on the FLUX Help Center. Then, please con-
tact your reseller, or FLUX technical support, in the case of directly purchasing from 
FLUX Inc. website, to diagnose the problem.

4. During each product’s warranty period, the following procedures might occur 
(1) sending parts to customer and tutorials for repair, (2) Approved return of the 
product to our authorized local reseller for (i) repair with new or refurbished parts, 
(ii) replacement with a new or refurbished product if:
- The product was properly used according to the manufacturer’s intended purpos
   es and instructions.
- The product was not damaged due to acts of nature, such as lightning, flood or fire.
- The product’s casing was never disassembled without permission.
*Note : Particles, scratches, unevenness, or other appearance issues which do not  
affect the function of the machine, are not covered by the warranty and cannot be 
replaced. 

5. Under the specified warranty period, our authorized local reseller may recall and 
repair your products and absorb the local shipping fee (international shipping is not 
included) without charging you.

6. Original packaging is required to claim warranty; shipping in any other packag
ing will not be accepted. We advise you to keep the original packaging for possible 
return. If there is a need for an original package, please contact our authorized local 
reseller for detailed purchase information.

Scope of Warranty

1.  FLUX Inc. warrants only the hardware  (excluding accessories and consumable 
parts) against defects in materials and workmanship when used as instructed in the 
manual. *Consumable parts include reflective mirrors, focus lenses, and vent hoses.

2. We offer a non-transferable limited warranty that covers products purchased from 
an authorized FLUX retailer against defects in materials or workmanship.

3. Customers must provide machine serial number and related information as proof 
of purchase. *Prior to returning any products, customers must receive an approval 
of shipping from our authorized reseller via email or phone. We will not accept any 
unapproved returned goods.
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Product Warranty Period

12 months

3 months

12 months

beamo / Beambox Compact / Beambox Pro 
(Laser Tubes excluded)

30W / 40W / 50W Laser Tube

beamo Rotary / Beambox Rotary /

Autofocus / Diode Laser Module / Beam Air

Warranty Period

Warranty period starts at the time of customer receipt of products.
Please see the chart below for the warranty periods of the products.

Post Warranty Support or Repairs

1. We continue to provide tech support via phone, email, and other online methods 
even when product warranty expires.

2. After the warranty period, all the costs, including but not limited to replacement 
parts, shipping charges, and testing fees are the responsibility of the customer.

3. Our authorized reseller will provide a quote for those possible items before 
recalling your products.
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CH 8

Disclaimer

Disclaimer
 
1. FLUX Inc. does not warrant against normal wear and tear, items consumed or   
   expended by their normal use, product misuse, or accidental damage. 

2. FLUX is not liable under this warranty if any damages or defects caused by :
(1) Improper (contrary to the stated purpose and scope of use described in 
     relevant documentation) use of Products or Add-ons; 
(2) External force;
(3) External water or moisture inside;
(4) Lightning strike, overvoltage, electric power or an electromagnetic field.
(5) Unauthorized change, correction and modification. Modification of the hard-

ware or accessories, including but not limited to replacing parts, making per-
manent cosmetic changes to the machine, replacing the software or firmware, 
or other unauthorized changes voids this warranty policy.

(6) Irresistible factors like earthquake, wars, fire, deluge and others natural or man- 
made calamities.

(7) Damaged by improper storage conditions, operation, application and trans-
portation.
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Add-on 
Introduction

With the use of different Add-on 
combination, the engraving materials 
can be diversified.
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Note: Add-ons may not be available for specific regions/countries.

Add-on Contents

Calibrate Camera

Autofocus

Reduced focus step 
with multiple cuts for 
deeper cuts

Autofocus module*1
2.5mm hexagonal wrench*1

Calibrate Camera

Rotary

Cylindrical 
object engraving

Rotary*1
Signal cable*1
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Add-on Introduction

Appendix 1-1

Diode laser module*1
Orange acrylic door cover*1
Door cover sticker*1
Focusing block*1
Positioning plate*1 
(for manual focusing)

Diode laser 
module

Delicate and shallow 
engraving
Specific types of 
stainless steel processing

Calibrate Diode 
Laser Module

Beam Air

Dust, tar and odor 
filtering

Beam Air*1
Pre-filter*4
Power cord*1
USB-A - USB-B cable*1 
Clamp*1



Appendix 1-2

Add-on 
Compatibility
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Rotary, diode laser module and autofocus can be matched with each other as 
shown in the table :

Rotary

Autofocus

Diode laser
module

Add-on Compatibility

Appendix 1-2
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Design
Software
Recommen-
dations
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Adobe
Illustrator

Affinity
Design

Sketch

SolidWorks

Rhinoceros

Vector graphics editor by Adobe Inc.

3D computer graphics and CAD 
application, abbreviated Rhino3D

Solid modeling CAD for Windows 
by SolidWorks

Vector graphics editor by Corel 
Corporation

Vector graphics editor for macOS 
by Sketch B.V.

3D modeling program for architects, 
urban planners, filmmakers, game 
developers, and related professionals

Vector graphics editor for Windows 
and macOS by Serif Ltd

Computer-aided design (CAD) and 
drafting software application by 
Autodesk, Inc.

Raster graphics editor by Adobe Inc.

Beam Studio supports the follow-
ing file formats :
SVG / PNG / JPG / DXF / PDF / AI
Version Support : 
Beam Studio supported operating 
system versions

Adobe
Photoshop

Autodesk
AutoCAD

SketchUp

Corel Draw

Design Software Recommendations

Appendix 2-1
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Exporting Adobe Illustrator SVG files :

If you are used to designing graphics in Adobe Illustrator and would like to export 
SVG files for use in Beam Studio, please refer to the following steps to export files 
to avoid incompatibility or non-support issues when importing into Beam Studio :

3. When the "SVG Options" 
window pops up, click "More 
Options" in the lower left corner. 

2. Select "SVG (svg)" > Click 
"Save".

I. Make sure the strokes are 
center-aligned before drawing :
Window - Stroke, set “Stroke” as 
“Align Stroke to Center”.

II. Save the file:
1. Click “File” > Click “Save As...”.
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4. Please follow the screen below to set the SVG Options > Click "OK" to finish 
saving the file.

III. Importing files into the software :
Import SVG files by dragging and dropping them into the Beam Studio window, 

or by clicking the "Picture"              button on the left side of the Beam Studio 

toolbar.

Design Software Recommendations

Appendix 2-1
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Exporting Inkscape SVG files :

If you are used to using Inkscape to design graphics and willing to export SVG files 
for use in Beam Studio, please refer to the following steps to export files to avoid 
incompatibility or unsupported problems when importing into Beam Studio :
I. Check the version of Inkscape : "Inkscape" > "About Inkscape", it should be ver-
   sion 1.0 or above.

II. Set the document properties before sketching : "File" > "Document Properties", 
set the Scale to 1.0 and the Units to mm.

III. Save the file : Click "File" > "Save As..." > Select "Plain SVG (*.svg)" > Check the 
box to export as SVG 1.1 > "Save".
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Design Software Recommendations

Appendix 2-1

IV. Importing files into the software : Drag and drop files into the Beam Studio 
window or click the "Image" button on the left side of the Beam Studio toolbar to 
import SVG files. If you import SVG 1.1, a reminder window will pop up, click "OK" 
to continue using the software.
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Design 
Inspiration
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Inspirations :

Graphic Resources :

Wood Crafts & Paper Crafts :

Free Fonts :

Pinterest Idea Board : https://pse.is/JXRR5
Ponoko 150 Laser Engraving Ideas : https://pse.is/HQARL

The Noun Projects (free vector graphics) : https://thenounproject.com/
Freepik (free vector graphics) : http://freepik.com/

DXF Projects (wood crafts) : https://dxfprojects.com/
Canon Creative Park (paper crafts) : http://cp.c-ij.com/sc/index.html
Paper-replika (paper crafts) : http://paper-replika.com/

Font-Bear (Japanese and Chinese characters) : https://fontbear.net/
Dafont (English characters) : https://www.dafont.com/

Search for “laser engraving” on Pinterest.com for more ideas

Design Inspiration

Appendix 2-2
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Maintenance 
Checklist
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Even if the machine is used sparingly, necessary maintenance items 
should still be maintained on time to ensure the machine health. 
Leaving the machine unused for a long time may accelerate the aging, 
regular use and proper maintenance is the way to avoid the machine 
from being out of action.

Maintenance Checklist provides the key points to be checked by users at different 
times, please follow the instructions of 【Maintenance】(p.124) for maintenance 
procedures.

Maintenance Checklist

Appendix 3

To download the form, please go to “FLUX > Supports > Help Center” > Search : 
Maintenance Checklist, download and print the checklist.
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* : Necessary maintenance



255

Maintenance Checklist

Appendix 3
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